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CHAPTERCHAPTERCHAPTERCHAPTERCHAPTER 1: 1: 1: 1: 1:

Bricscad V10 for
AutoCAD Users

THIS BOOK IS designed to help you make the transition from
AutoCAD® to Bricscad. In it, you will learn about the pros and the
cons of using Bricscad in place of AutoCAD. You'll read about the
advantages of switching to another — yet very similar — CAD pack-

age, as well as some of the pitfalls to watch out for.

The chapters in this book discuss topics such as learning about file compatibility with AutoCAD, be-
coming familiar with the Bricscad user interface, and customizing it. The book also includes appendi-
ces that exhaustively cross-reference commands, system variables, aliases, keystrokes, and button
actions between the two CAD systems.

Bricscad for AutoCAD Users is meant for several type of CAD users:

• AutoCAD users considering switching to Bricscad

• Firms adding licenses of Bricscad to complement their AutoCAD shop

• Companies working with clients who use the other CAD package

Or perhaps you are simply wondering about the differences between the market leader AutoCAD and
the aggressive up-and-comer Bricscad. This book is for you.
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The Entire Bricscad Product LineThe Entire Bricscad Product LineThe Entire Bricscad Product LineThe Entire Bricscad Product LineThe Entire Bricscad Product Line

Executives at Autodesk have grown the company into a two-billion-dollar-a-year company, becoming the
largest CAD software company in the history of the world. But with size comes risk.

Risky BusinessRisky BusinessRisky BusinessRisky BusinessRisky Business

Autodesk offers over a hundred software packages and bundles (at time of writing), and AutoCAD itself comes
in more than twenty variations, such as the LT and OEM versions. It is also available in complex combinations
with Autodesk’s other software, such as the AutoCAD Revit Architecture Visualization Suite and AutoCAD
Inventor Routed Systems Suite. It can be tough to choose.

Given the amount of software available from the largest CAD software company, making purchasing decisions
can be risky as Autodesk fine-tunes its offerings to maximize profits. In recent months, Autodesk announced
it is abandoning its facilities management software (FMdesktop); it halted further development of its con-
struction management software, Constructware. In previous years, it orphaned its Actrix Technical diagram-
ming software, AutoCAD-based Mechanical Desktop 3D mechanical software, StudioDesk conceptual model-
ing software, and other software.

Autodesk tends to price its products high. Its foundational drafting package, AutoCAD, has a list price of
US$4,000 — some 4x to 8x more costly than is usual for productivity software. The high price of AutoCAD is
just the start: one of its previous CEOs famously boasted to financial analysts that the company can make up
to ten times more money from customers who move up from AutoCAD to its 3D modeling software.

Once customers decide on which version of AutoCAD to license, they are pressured into also purchasing
annual subscriptions; for many products, however, the subscription payment is mandatory. Targeting custom-
ers who forego making annual subscription payments, Autodesk recently tripled the price of some upgrades
to as much as 50% of the product’s list price — $2,000 in the case of AutoCAD.

Customers must agree terms in a software license that permits Autodesk to send agents into private homes
and businesses to search for unauthorized copies. It also stipulates that Autodesk software can only be used
in the country in which it was purchased, making it illegal for customers to take part in today’s world of
globalized business.

In recent years, Autodesk has unfortunately become the most litigious of all CAD vendors, launching law suits
against competitors for reasons as trivial as using the color orange for a rectangle on product packaging, and
for using the generic DWG file extension in product naming.

Bricsys BusinessBricsys BusinessBricsys BusinessBricsys BusinessBricsys Business

In contrast, Bricsys makes the choice easy by offering three products:

• Bricscad Pro — full featured CAD

• Bricscad Classic — lower priced CAD

• Vondle — browser-based project management

Bricsys does not charge customers high prices, doesn’t impose mandatory subscriptions, and doesn’t sue its
competitors. The software license terms allow you to use the software in any country; Bricsys does not threaten
to send agents into your home.
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Bricscad Pro is the full-featured version of Bricscad. The Classic version is nearly identical, but cheaper, because
it leaves out features for which Bricsys pays royalties to other software companies. The Classic version excludes
ACIS modeling and editing, and VBA and BRX programming.

Bricscad Classic Includes Bricscad Pro Includes

ACIS viewing ACIS viewing, plus
ACIS modeling and editing

DRX only DRX, plus
BRX, VBA, and VBA DVB projects

Bricscad uses the highly compatible Open Design Alliance libraries to read/write DWG files.

Vondle Project ManagementVondle Project ManagementVondle Project ManagementVondle Project ManagementVondle Project Management

Bricsys offers everyone Vondle, its professional browser-based communication, collaboration, and project
management system. Unlimited access is available to an unlimited number of participants through a yearly flat
fee based on industry type and company size.

Vondle project management offers you:

• Speed. You can view multi-megabyte-large drawings in seconds, zooming in on a detail, and examine annota-
tions with fly-over text that lists time stamp and author.

• Compliance management. You can follow a continuous audit trail of the entire project process. Vondle
automatically maintains a log file of project activities and participants.

• Single access point. You have a repository of all actions, documents, meetings, and participants in a single
location.

• No software to install. You work with an ASP (application service provider) system. The software runs on
central servers with guaranteed access 24/7; you only need an Internet connection and a supported Web
browser.

• Integration with Bricscad v10. Access the Vondle site directly through Bricscad’s File | Vondle/eBridge com-
mand.

Bricsys provides these Vondle tools free to make project management easier on your computer:

VondleExplorer is a Windows shell extension for synchronizing local files and folders with Vondle. The usual
Vondle operations on documents are possible in the Windows environment on your computer.

VondleTray performs offline reviewing and editing of Vondle documents. It manages the downloading of
documents to your computer, and keeps track of their status.

VondleUpload (for Windows, Mac, and Linux) uploads to Vondle multiple files at once to different projects
and folders.

For more information on Vondle, see www.bricsys.com/en_INTL/vondle.
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The Advantages of BricscadThe Advantages of BricscadThe Advantages of BricscadThe Advantages of BricscadThe Advantages of Bricscad

Bricscad doesn’t just lack the negative aspects of AutoCAD; it has its advantages. These include a nearly-
identical user interface, additional commands and system variables, support for operating systems other than
Windows, a no-charge developer network, and lower pricing.

Near-identical User InterfaceNear-identical User InterfaceNear-identical User InterfaceNear-identical User InterfaceNear-identical User Interface

When you launch Bricscad for the first time, you will notice that it looks very much like AutoCAD 2008 —
complete with command prompt. If you do not care for the Microsoft-designed ribbon interface that Autodesk
added to AutoCAD 2009, then you will love Bricscad for sticking to toolbars and menus.

As the appendices at the back of this book amply illustrate, Bricscad uses the same names for many AutoCAD
commands, system variables, aliases, and even keystroke shortcuts. Those missing are mostly commands you
probably weren't using in AutoCAD anyhow, such as those for database linkages and sheetset management.

Bricscad is available in English and 12 other languages. Chapter 2 describes the user interface in greater detail.
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Added Commands and System VariablesAdded Commands and System VariablesAdded Commands and System VariablesAdded Commands and System VariablesAdded Commands and System Variables

While Bricscad lacks some of AutoCAD’s more than 1,300 commands and system variables, Bricscad has a
number that are lacking in AutoCAD. For example, all object snaps are their own command, such as Intersec-
tion and Midpoint. Bricscad has more options for selecting objects, such as the circular and external selection
sets. There are commands for manipulating extended entity data, something that is available in AutoCAD only
through programming. The PdfOptions command makes exporting drawings as PDF files more convenient.

AutoCAD stores a number of user settings in locations that can be difficult to access; some are even unavail-
able through system variables.  Bricsys has added system variables to return access to many of these settings.
For example, BkgColor specifies the background color of the drawing area, and CmdLineFontName sets the
name of the font used by the command bar.

All of Bricscad system variables and options are summarized in a single dialog box accessed through the
Settings command.

Multiple Operation System SupportMultiple Operation System SupportMultiple Operation System SupportMultiple Operation System SupportMultiple Operation System Support

Bricsys has been rewriting the Bricscad code to make it independent of the operating system. The effort will
allow the company to offer versions of Bricscad that run natively on the Linux and Mac OS X operating systems.
The Windows version of Bricscad already runs on Macintoshes using Bootcamp. The company speculates that
in the future Bricscad might even be able to run on operating systems meant for cell phones (mobile phones
or “handis”) and Web browsers, like Android or ChromeOS.

Sign up for the Bricsys Web site’s RSS feed at www.bricsys.com/rss/rss.jsp?channel=bcad for breaking news on
Linux and Mac.

No-charge Developer NetworkNo-charge Developer NetworkNo-charge Developer NetworkNo-charge Developer NetworkNo-charge Developer Network

Unlike most other CAD vendors, Bricsys does not charge third-party developers. You do not pay a fee to join;
you do not pay an annual membership; you do not pay for support; you do not pay royalties on shipping
products.

The reason is that Bricscad decided to become a successful CAD
company by encouraging many add-on applications. Indeed, the
tag line in the Bricscad V10 About dialog box now reads "En-
abling Applications."

The company feels so strongly about third-party development that it has halted its own add-ons. It concen-
trates on two things only:

• Improving Bricscad

• Improving the APIs

When third-party developers request additions to the API, the new code also becomes new features in Bricscad
that end-users can employ.
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APIsAPIsAPIsAPIsAPIs

Bricsys is making it easier for third-party developers to adapt their AutoCAD add-ons to Bricscad — just
as Bricsys is working to make it easy for AutoCAD users to learn Bricscad. For this reason, Bricscad
supports almost the same list of APIs as does AutoCAD:

AutoCAD API* Bricscad Equivalent Notes

AutoLISP LISP AutoLISP code runs as-is in Bricscad, no changes needed
Diesel Diesel Diesel code runs as-is in Bricscad, no changes needed
DCL DCL DCL code runs as-is in Bricscad, no changes needed
VBA VBA AutoCAD VBA code runs as-is in Bricscad, no changes needed
ADS SDS ADS code requires only a recompile using new SDS headers
ARX BRX ARX code requires only a recompile using new BRX headers

DRX ARX code must be checked carefully when used with DRX
COM COM AutoCAD COM code runs as-is in Bricscad, no changes needed
.Net DWGdirect.NET AutoCAD .Net code will be supported by Bricscad in the future
(Managed wrapper classes)
VSTA ... Unavailable in Bricscad
*) API is short for “application programming interface,” and is the software link between CAD software and programming
    languages/compilers.

Generally, Bricscad provides a nearly identical subset of equivalent function names. In the case of non-com-
piled code, such as LISP and DCL, you just drop it into the Bricscad environment. For compiled code, you
recompile using the headers provided by Bricsys.

Examples of Add-onsExamples of Add-onsExamples of Add-onsExamples of Add-onsExamples of Add-ons

Independent programmers have written dozens of add-ons that tailor Bricscad for specific applications in the
areas of AEC, civil, data exchange, electrical, GIS, survey and mapping, general tools, HVAC, mechanical, pack-
aging, rendering, and structural design. Here are just a few examples:

Left to right: CivilCAD2010, Engcad, and Architecturals

• ADACX creates and edits ADAC-standard civil infrastructure drawings for Australian Councils.

• CivilCAD2010 provides surveying, road construction and design tools, water engineering features, land
volumes calculations and realtime 3D simulation.

• 3DM Export exports Bricscad drawings in Rhinoceros 3DM format.

• CP-System Electrical designs lighting systems, low-tension, power plant, aerial, alarm and other electrical
installations.
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• GeoBL creates topographic plans and includes a library with topographic symbols.

• StrucPLUS is a complete set of tools for preparing structural engineering drawings.

For the complete list of applications available for Bricscad, visit their Applications eStore at www.bricsys.com/
common/applications/applicationlist.jsp.

Lower Purchase and Maintenance PricingLower Purchase and Maintenance PricingLower Purchase and Maintenance PricingLower Purchase and Maintenance PricingLower Purchase and Maintenance Pricing

Bricscad Pro with annual maintenance is seven times cheaper than AutoCAD. To put it another way, you can
outfit seven workstations with Bricscad Pro for the price of just one with AutoCAD.

The current list prices at time of writing are as follows:

Item AutoCAD1 AutoCAD LT1 Bricscad Pro2 Bricscad Classic2

License3 $3,995 $1,195 $470 $365
Maintenance $400 $195 $155 $155
1 USA pricing only; usually higher in other countries.
2 International pricing (one price for all countries).
3 Single-use license; lower pricing available for multi-seat purchases, networked versions, upgrades;
taxes not included.

See https://www.bricsys.com/estore/estore.jsp for full details on pricing and Bricscad products.

It Makes More than CentsIt Makes More than CentsIt Makes More than CentsIt Makes More than CentsIt Makes More than Cents

You could ask, “Are AutoCAD’s additional commands worth the $3,525 difference in price?” For some users, it
makes sense to pay for the ability to manage sheetsets, generate database links, and perform 3D mesh model-
ing.

But another user might think: “I can get more mature 3D mesh modeling with Rhino at $1,000, and then get
the Rhino->Bricscad file converter for $195) — and still be two thousand dollars ahead.” For example, model
a boat hull in Rhino, and then draw 2D details with annotations in Bricscad. (Rhino is available from Robert
McNeel & Associates at www.rhino3d.com/download.htm; the converter is sold at the Bricsys eStore.)
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Bricscad is Not IntelliCADBricscad is Not IntelliCADBricscad is Not IntelliCADBricscad is Not IntelliCADBricscad is Not IntelliCAD

Some readers may be familiar with the heritage of Bricscad, and know that it was based on IntelliCAD. "Was"
is the operative word here.

The earliest versions of Bricscad were simply rebranded versions of IntelliCAD, an AutoCAD workalike pro-
grammed by the IntelliCAD Technical Consortium. Belgium-based Bricsys sold the software primarily in north-
ern Europe.

(A little history: In 1998, the ITC was created by Visio, now part of Microsoft, after deciding it no longer wanted
to be in the CAD market. Visio had originally purchased “Project Phoenix” from SoftDesk, the largest AutoCAD
third-party developer in the world in the mid-1990s. SoftDesk began coding Phoenix after executives worried
that Autodesk might cut them off, as the software giant had done to another major third-party developer.
When Autodesk purchased SoftDesk, the US Federal Trade Commission required it to spin off Phoenix. That
was when Visio made the purchase, but then spun of the IntelliCAD code to the ITC in 1998. Today, the ITC
continues to update IntelliCAD while consortium members rebrand the software with additional features for
resale in their regions.)

For several years, Bricsys wrote additional code for Bricscad, contributing the code back to the ITC. Bricsys
found, however, that it was writing the new code faster than the ITC could integrate it for its many members.
Bricsys had to decide between “forking” the code (creating two versions, their own and an IntelliCAD-compat-
ible one) or going their own way. They chose the latter.

With Bricscad V8 and V9, the company began replacing ITC code with their own. As of Bricscad V10, the
software is entirely their own, and no longer mentions IntelliCAD or Visio in the About dialog box (as does the
one for V9, illustrated above).

Code replacement is a huge undertaking, and explains why V8 and V9 didn’t seem to sport very many new
earth-shaking features — most of the work was going on under the hood.

What’s Missing from BricscadWhat’s Missing from BricscadWhat’s Missing from BricscadWhat’s Missing from BricscadWhat’s Missing from Bricscad

Bricscad doesn’t have every feature that you find in AutoCAD. Here is a list of the things I found Bricscad lacks
(some are displayed and uneditable by Bricscad if found in drawings, such as tables):

Aerial view Animations (walk and fly) Annotation scaling AutoPublish

CAD standards Database links Dynamic blocks Geographic positioning

Lights and materials Markups Mesh modeling Multilined attributes

Multilines Multline leaders Quick properties Quick view thumbnails

Rendering Sections Sheetsets Surface modeling

Tables Tool palettes Workspaces
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At first glance, other AutoCAD features also appear to be missing but they have near-equivalents in Bricscad:

AutoCAD Feature Bricscad Equivalent Command(s) in Bricscad

Action Recorder Script recorder RecScript, StopScript
Geometric Constraints Due to be added to Bricscad v10.1 ...
Dimensional Constraints Due to be added to Bricscad v10.1 ...
QLeader Leaders DimLeader
Ribbon Toolbars and menus Toolbar, Customize
VSTA VBA VBA

System RequirementsSystem RequirementsSystem RequirementsSystem RequirementsSystem Requirements

A further advantage to Bricscad is that it has milder hardware and operating system requirements than does
AutoCAD. This is significant for two reasons:

• Bricscad can run on older computers; it is not necessary to employ high-end hardware nor to install the special
display drivers as for AutoCAD.

• Bricscad has more RAM and CPU speed headroom on newer computers than does AutoCAD.

Operating SystemsOperating SystemsOperating SystemsOperating SystemsOperating Systems

Bricsys also supports Bricscad running on older releases of the Windows operating system; Autodesk no longer
does. Both CAD programs operate on Windows 7, according to my informal testing.

AutoCAD Bricscad

... Microsoft Windows NT

... Microsoft Windows 2000
Microsoft Windows XP SP2 Microsoft Windows XP
Microsoft Windows Vista SP1 Microsoft Windows Vista

AutoCAD also requires Internet Explorer 7 or later; Bricscad does not.

Linux and Mac OS X SupportLinux and Mac OS X SupportLinux and Mac OS X SupportLinux and Mac OS X SupportLinux and Mac OS X Support

Bricsys plans to release Bricscad running natively on Linux and Mac OS X. Autodesk supports AutoCAD running
on Macintosh computers through Parallels Desktop and Windows; the company, however, has not announced
plans for neither a native Mac or Linux version (at time of writing).
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Recommended HardwareRecommended HardwareRecommended HardwareRecommended HardwareRecommended Hardware

Autodesk and Bricsys recommend that your computer meet the following specifications. Note that AutoCAD
2010 will not run on older CPUs lacking SSE2*.

Hardware AutoCAD Bricscad

CPU: 1.6GHz with SSE2* (XP) 1GHz Pentium III-compatible CPU
2.0GHz dual-core SSE2 (3D modeling)
3.0GHz with SSE2 (Vista)

Minimum RAM: 2GB 256MB, plus RAM required by OS
Recommended RAM: 1GB or more
Hard Disk Space: 1GB for program files 100 MB for program files
Display: 1024x768 with true color (minimum) 1024x768 with true color (minimum)
Graphics Board: Direct3D 128MB (minimum) workstation- Any

class; supported brands specified at
www.autodesk.com/autocad-graphicscard

Pointing Device Mouse Mouse

*) SSE2 is short for “streaming SIMD (single instruction, multiple data) extension 2. It allows CPUs to assist with
    certain math functions and vector transformations of the sort used by CAD applications.

Netbook SupportNetbook SupportNetbook SupportNetbook SupportNetbook Support

Both CAD programs also operate on netbooks. The figure below illustrates low-cost Bricscad running on a low-
cost netbook with Windows 7:

According to my informal testing, both programs need some tweaks to handle non-registering registry entries.
Bricscad does not suffer from the installation problem exhibited by AutoCAD, where the netbook requires a
higher-resolution external monitor. (Autodesk’s installation screens are too large for the standard 1024x600-
resolution screen found on netbooks.)
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AutoCAD-Bricscad DictionaryAutoCAD-Bricscad DictionaryAutoCAD-Bricscad DictionaryAutoCAD-Bricscad DictionaryAutoCAD-Bricscad Dictionary

Bricscad’s terms closely follow AutoCAD’s jargon, but there are a few differences.

AutoCAD Term Bricscad Equivalent

Object Entity
Osnap Esnap (entity snap)
Intersection 2dIntersection
Implied Intersection 3dIntersection
ADS SDS (Software development system)
ARX BRX (Bricscad runtime extension)

DRX (Design runtime extension)
AutoLISP LISP
DesignCenter Explorer
Options Settings
VisualStyle ShadeMode
Xdata EED (extended entity data)

IN SUMMARY, Bricscad operates a lot like AutoCAD — yet is much more economical. In the following chap-
ters, we delve deeper into the themes sketched out by this chapter.

Just as you can try out AutoCAD free for 30 days, you can install and run Bricscad for 30 days at no charge from
www.bricsys.com/open/common/download.jsp?p=BCAD. (Only Microsoft’s VBA is disabled in the trial ver-
sion.) The size of the Bricscad download file is 90MB, some 16x smaller than AutoCAD’s 1.5GB download file.
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CHAPTERCHAPTERCHAPTERCHAPTERCHAPTER 2: 2: 2: 2: 2:

Comparing User
Interfaces

BRICSCAD LOOKS LIKE AutoCAD 2008, as well as more recent releases when the
workspace is set to “AutoCAD Classic,” as illustrated on the next pages. The similari-

ties and differences are summarized by the boxed text on a later page.

As in AutoCAD, Bricscad defines aspects of its user interface through the content of CUI files
(short for “customize user interface”) and the settings of system variables. In general, AutoCAD has

more capability in its CUI files, while Bricscad provides more control through system variables.
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Title Bar

Docked Toolbar

Menu Bar Toolbar

Layout Tabs

Status Bar Command
Prompt

Entity Properties

x, y, z coordinates

Cursor

Bricscad V10 User InterfaceBricscad V10 User InterfaceBricscad V10 User InterfaceBricscad V10 User InterfaceBricscad V10 User Interface
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Drawing Area

Resize
Window

Window
Controls

Status Buttons

Horizontal Scroll Bar

Vertical Scroll Bar

UCS Icon

Properties Bar
(palette)

Properties
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Summary of User Interface Elements

Bricscad and AutoCAD have similar user interface elements, although some are unique to each package.

AutoCAD Bricscad

Customizable UI Customizable UI
Menu bar (turned off in default workspace) Menu bar
Toolbar (turned off in default workspace) Toolbars
Ribbon ...
Scroll bars (turned off, by default) Scroll bars
Command bar Command bar
Tooltips Tooltips
Rollover tooltips ...
Layout tabs Layout tabs
QuickView layouts and drawings ...
Status bar Status bar
Workspaces ...

On the Drawing Screen
Tri-color cursor Tri-color cursor
Aperture cursor Aperture cursor
Pickbox cursor Pickbox cursor
Grips Grips
Selection highlighting Selection highlighting
Selection previews ...
AutoSnap markers AutoSnap markers
Autotrack vectors Autotrack vectors
Steering Wheels ...
Navigation Cube ...
UCS icons UCS icons
Aerial View window ...

Command Bar & Mouse
Keyboard input Keyboard input
Prompt (options) menus Dynamic input
Keyboard shortcuts Keyboard shortcuts
Double-click actions Double-click actions
Mouse buttons Mouse buttons
Shortcut menus Shortcut menus

Information Centers
DesignCenter Explorer
Tool palettes ...
InfoCenter ...
Quick Access toolbar ...
Quick Properties palettes ...
Properties palette Properties palette



chapter 2 • Comparing User Interfaces 2323232323

DesignCenter vs Drawing ExplorerDesignCenter vs Drawing ExplorerDesignCenter vs Drawing ExplorerDesignCenter vs Drawing ExplorerDesignCenter vs Drawing Explorer

Bricscad's Drawing Explorer is comparable to AutoCAD’s DesignCenter, but provides somewhat more informa-
tion and far greater control. Indeed, Explorer centralizes what would be separate dialog boxes in AutoCAD,
such as Layers, UcsMan, and ExternalReferences. (AutoCAD has begun to amalgamate commands with similar
functions.)

You access Drawing Explorer through the Explorer command, or from the menu: Tools | Drawing Explorer.

Above: AutoCAD Design Center
Below: Bricscad Drawing Explorer

TIP Bricscad has a number of other commands that access Drawing Explorer. These commands open Explorer, and then
highlight the related node. For example, the Layers command opens Explorer at the Layers node. These commands are:
DdUcs ExplBlocks ExpUcs Image Layer LayerState Linetype Rename View Xref
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Drawing Explorer handles the named entities listed in the table below:

AutoCAD Bricscad
DesignCenter Drawing Explorer Notes

Blocks Blocks AutoCAD controls blocks with the Insert command
... Coordinate Systems (UCS) AutoCAD lists UCS names with the UcsMan command
Dimstyles Dimension Styles AutoCAD controls dimension styles with the DimStyles command
Xrefs External References AutoCAD controls xrefs with the ExternalReferences command
... Images AutoCAD lists images with the ExternalReferences command
Layers Layers AutoCAD controls layers with the Layers command
... Layer States AutoCAD lists layer states with the LayerStates command
Layouts ... Bricscad does not list layout names
Linetypes Linetypes AutoCAD controls linetypes with the Linetypes command
Multileaders ... Bricscad does not create multileaders
Tablestyles ... Bricscad does not create tables
... Text Styles AutoCAD lists text style names with the Style command
... Views AutoCAD lists view names with the View command

Bricscad includes settings for modifying these named entities, a benefit found lacking in AutoCAD’s DesignCenter.
For example, the Linetypes node lets you load additional linetypes:

... and the Dimension Styles node lets you modify the styles:
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In summary, Drawing Explorer is more than DesignCenter; it centrally gathers commands for inserting and
controlling named entities. The unified interface of Drawing Explorer replaces the equivalent of ten dialog
boxes in AutoCAD, by my count.

Options vs SettingsOptions vs SettingsOptions vs SettingsOptions vs SettingsOptions vs Settings

Bricscad’s Settings dialog box is a greatly expanded version of AutoCAD’s Options dialog box. In AutoCAD, the
dialog box changes the values of many system variables; Bricscad took the concept to its logical conclusion —
to access all system variables. See Appendix B for the complete list.

Providing easy access to six hundreds system variables is a difficult problem from the standpoint of designing
an interface for users. Autodesk segregates system variables into logical categories by outfitting AutoCAD’s
Options dialog box with 10 tabs, 16 droplists, and 31 auxiliary dialog boxes.

In contrast, Bricsys places all system variables in a single dialog box, and then segregates them by two methods:
sorted into logical categories and by alphabetical order. The two modes are illustrated below.

Left: Bricscad’s Settings dialog box in Categorized mode...
Right: ...and in Alphabetic mode.
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You access the Settings dialog box through the Settings command, Options alias, or from the menu: Settings
| Settings.

Categorized values

Toolbar

Helpful information

Checkbox

Droplist

Preview image

TIPS The preview area of the Settings dialog box shows system variable names in UPPERCASE and user preferences in
Mixed Case. An icon indicates settings that are unique to Bricscad.

Commands and system variables other than Settings open the dialog box at the related node:
     DdEModes DdFilter DdGrips DdPType DdSelect DdSettings DdSTrack LWeight PdfOptions
For example, the LWeight command opens Settings at the Lineweights section.

The SetVar command and system variables also operate at the command prompt, as you would expect them to:
Command: setvar
Variable name or ?: pdmode
New current value for PDMODE <4>: (Enter a number, and then press Enter.)

Settings ToolbarSettings ToolbarSettings ToolbarSettings ToolbarSettings Toolbar

The toolbar in the Settings dialog box is designed to provide you with quick access to Bricscad’s 487 system
variables (at time of writing).

Categorize or Alphabetic

Export to CSV file

Search

Jump to Drawing, Dimensioning, Program Options sections

Changing SettingsChanging SettingsChanging SettingsChanging SettingsChanging Settings

To access values, use the search field described later, or else click the + boxes to open sections. (Click the -
box to close sections.)

Click to close section

Click to open section

Section
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Accessing and Changing ValuesAccessing and Changing ValuesAccessing and Changing ValuesAccessing and Changing ValuesAccessing and Changing Values

The Settings dialog box lists some 487 settings in three primary categories:

• Drawing

• Dimension

• Program Options

To access values, use the Find button, or else click the + boxes to open sections.

Click to close section

Click to open section

Section

This dialog box allows you to change most values, like this:

1. Navigate to the value you want to change.

2. Click the value.

3. Depending on the value, you either check a box, select an option from a droplist, or type in a new value, as
illustrated below. When a value is changed, it turns to boldface — a way of alerting you that a change took
place.

Changes are made immediately, which is why there is no Apply or OK button. To exit the dialog box, click the
x in the upper right corner.

Realtime SearchRealtime SearchRealtime SearchRealtime SearchRealtime Search

The realtime search field lets you directly access system variables by name. As you enter the first few letters,
Bricscad immediately jumps to the first name that matches. Click the  left and right arrows to move back
and ahead through the matching candidates.

The search field changes color to report its status to you:

Snow — two or more names match the search phrase.

Lime — only one (or the last) name matches the search phrase.

Tangerine — no names match the search phrase.
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TIP Click the  Export button to save the variable names and values in CSV (comma separated values) format, which
can be imported into OpenOffice Calc and other spreadsheet programs.

User Interface VariationsUser Interface VariationsUser Interface VariationsUser Interface VariationsUser Interface Variations

Although the user interfaces of both programs are very similar, there are some subtle differences. These
include the prompt menu, the command prompt, and the variety of command options.

Prompt Menu vs Dynamic InputPrompt Menu vs Dynamic InputPrompt Menu vs Dynamic InputPrompt Menu vs Dynamic InputPrompt Menu vs Dynamic Input

The one user interface element unique to Bricscad is the prompt menu, a floating menu that appears whenever
a command contains options. The initial prompt menu for the Circle command is illustrated below. As the
prompts change, so does the content of this menu.

Above, left: Prompt menu in Bricscad.
Above, right: Dynamic prompt in AutoCAD.

Below:  The command bar displaying equivalent options.

You can type options in the command bar, or use the mouse to choose options from the prompt menu. (The
closest equivalent in AutoCAD is dynamic input.) To cancel the command, click Cancel.

The prompt menu does not appear when you are prompted to select objects, when commands display dialog
boxes, or when it has been turned off. Bricscad also displays AutoCAD-like shortcut menus during commands,
that are accessed by pressing the right mouse button.



chapter 2 • Comparing User Interfaces 2929292929

Controlling the Prompt MenuControlling the Prompt MenuControlling the Prompt MenuControlling the Prompt MenuControlling the Prompt Menu

You can determine whether the prompt menu appears or not, as well as specify its location on the screen.
Open the Settings dialog box with the Settings command, and then enter “prompt menu” in the search field.

The Don’t Display and Display options toggle the prompt menu; the Corner option displays the prompt
menu in one of the four corners of the drawing area.

: vs Command:: vs Command:: vs Command:: vs Command:: vs Command:

Bricscad uses ‘:’ as the command prompt, to indicate it is ready for you to enter a command. (AutoCAD uses
‘Command:’).

If you prefer the AutoCAD prompt wording, you can change the ‘:’ to ‘Command:’ through the Settings dialog
box. Search for ‘prompt prefix’. Enter any text you like, even silly text:

More Command OptionsMore Command OptionsMore Command OptionsMore Command OptionsMore Command Options

You may have noticed that Bricscad’s Circle command contains more prompts than does that of AutoCAD. This
is not uncommon in Bricscad, where many commands contain additional useful options not found in AutoCAD.
The following table compares the two:

AutoCAD Circle Options Bricscad Circle Options Notes

Specify center point Center of circle Default option
2P 2Point
3P 3Point
Ttr TanTanRad
... Arc Converts arcs into circles
... Multiple Draws multiple circles

Properties Palette vs Properties BarProperties Palette vs Properties BarProperties Palette vs Properties BarProperties Palette vs Properties BarProperties Palette vs Properties Bar

When AutoCAD’s user interface was organized around toolbars, users could glance at the “dashboard” of
property settings, as illustrated below. In an instance, they could monitor the settings of the workspace, layer,
text styles, and so on — ten properties in all.
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With the redesign of AutoCAD’s user interface around the ribbon, seeing properties at a glance has become
more difficult. The Home tab of the 2D Drafting & Annotation ribbon shows just four properties, and none in
the same tab of the 3D Modeling ribbon. The remaining properties are “hidden” in droplists and other tabs.

In contrast, Bricscad maintains the dashboard-like experience of a Properties toolbar in its default configura-
tion.

In addition, the status bar of Bricscad reports some properties and allows you to modify them. Both CAD
packages share a similar Properties palette, but Bricscad calls it the “Property bar.”

Properties BarProperties BarProperties BarProperties BarProperties Bar

The Bricscad Properties Bar operates just like the equivalent Properties Palette in AutoCAD. That is, it presents
properties in three states:

• No entities selected — reports the current state of global properties; default properties can be changed.

• One entity selected — reports the state of the entity’s properties; properties can be changed.

• Two or more entities selected — reports the state of properties common to the selected entities; properties
can be changed.

Left: Properties palette in AutoCAD.
Right: Properties bar in Bricscad.
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As with the Settings dialog box, the Properties bar is used where AutoCAD might have numerous other dialog
boxes. AutoCAD’s HatchEdit command, for example, opens the Hatch Edit dialog box; the same command in
Bricscad opens the Properties bar.

You access the Properties bar through the Properties command, or from the menu: Modify| Properties. It
appears automatically when you double-click specific entities in drawings.

TIP These Bricscad commands also access the Properties bar:   HatchEdit MtEdit MtProp SplinEdit

Status BarStatus BarStatus BarStatus BarStatus Bar

In addition, the status bar in Bricscad reports the properties of text and dimension styles:

To change a text or dimension style, right-click the current name, and then choose a different one from the
shortcut menu.

(The status bar does double duty: when the command bar is turned, off, prompts appear on the status bar.)

TIP Right-click the coordinates on the Bricscad status bar to change drawing units quickly:

Mouse ButtonsMouse ButtonsMouse ButtonsMouse ButtonsMouse Buttons

Buttons on the mouse operate the same way in Bricscad as they do in AutoCAD:

• Left — pick

• Right — context-sensitive shortcut menu

• Shift+Right — Entity snap shortcut menu

• Center — realtime pan

• Rollerwheel — realtime zoom in and out
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Holding down the Ctrl key together with a mouse button lets you change the view in real time, as follows:

• Ctrl + Left — rotates the viewpoint (2D rotation)

• Ctrl + Right — orbits the viewpoint (3D rotation)

Let go of the mouse button to stop the real time rotation.

Unlike AutoCAD, the mouse buttons cannot be customized by Bricscad. As of Bricscad v9.1.3, Bricscad fully
supports an AutoCAD-like menu overlay system and customizable buttons for digitizing tablets.

Selection SetsSelection SetsSelection SetsSelection SetsSelection Sets

As in AutoCAD, you can create complex selection sets through entity location (pick, Window, Crossing, etc) and
through entity properties (color, linetype, and so on). Press Ctrl+A to select all entities in the drawing. Below,
the prompt menu lists the names of all of the Select command’s options. (Recall that AutoCAD’s Select
command displays no options at all.)

Bricscad has these additional selection modes:

• Outside window — selects all entities fully outside of a rectangular window.

• Outside polygon — selects all entities fully outside of an irregular polygon.

• Window circle — selects all entities fully within a circle.

• Crossing circle — selects all entities within and crossing a circle.

• Outside circle — selects all entities fully outside of a circle.

THIS CHAPTER HIGHLIGHTED the (few) differences between the user interfaces of Bricscad and AutoCAD.
The next chapter examines how both programs display and edit entities in drawing files.
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CHAPTERCHAPTERCHAPTERCHAPTERCHAPTER 3: 3: 3: 3: 3:

Drawing File
Compatibility

BRICSCAD READS AND writes drawing files compatible with the DWG and DXF files
created by AutoCAD 2009 and earlier.

Whereas AutoCAD reads and writes drawing files as old as DWG Release 14, Bricscad
goes all the way back to DWG v2.5, the equivalent of DWG “Release 7.” (AutoCAD

can export drawings to Release 12 format, but only by translating them to DXF.)

Bricscad, however, does not support DWG 2010 (at time of writing); Bricsys plans to add support with
Bricscad v10.1. Therefore, there is currently no support for 3D mesh objects and PDF underlays.

This chapter summarizes how well Bricscad reads entities created by AutoCAD 2009. Most entities, as
we will see, are correctly read, created, edited, and written by Bricscad.
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DWG CompatibilityDWG CompatibilityDWG CompatibilityDWG CompatibilityDWG Compatibility

Bricscad displays all entities in drawings created by AutoCAD 2009.

How Entities Are TestedHow Entities Are TestedHow Entities Are TestedHow Entities Are TestedHow Entities Are Tested

To test Bricscad’s compatibility with AutoCAD entities, I employed the following procedure:

1. Each entity was drawn in AutoCAD 2009, and then saved as a DWG file.

(Entities specific to AutoCAD 2010 were drawn in AutoCAD 2010, and then saved as a DWG 2007/8/9 file.)

2. The DWG file was opened in Bricscad v10.

3. Entities were examined for the following characteristics:

• Translation: did the entity appear in Bricscad?

• Visual accuracy: did the entity look the same in Bricscad as in AutoCAD?

• Editability: could Bricscad edit the entity?

• Constructability: does Bricscad have a command for creating the entity?

4. Screen grabs were made of each entity.

5. Limitations were recorded, if any.

The results of this testing are presented on the following pages. Entities are segregated into the following
categories:

• 2D entities

Entity properties

• Text entities

Text styles

Table styles

• Dimension entities

Dimension styles

Leader styles

Mleader styles

• Complex 2D entities

Multiline styles

• 3D entities

Problem EntitiesProblem EntitiesProblem EntitiesProblem EntitiesProblem Entities

Those AutoCAD entities that are not fully supported by Bricscad sport the following legend:

Entity Name READ / CREATE / EDIT

Read — Bricscad reads the entity and displays it correctly.

Create — Bricscad can create the entity.

Edit — Bricscad can edit the entity.

Any entity that Bricscad can read, create, and/or edit, it can also write.



chapter 3 • Drawing File Compatibility 3535353535

For example, Bricscad can read and edit multilines, but cannot create them, and so multilines are tagged with
this version of the legend:

Multlines AutoCAD Bricscad * READ / — / EDIT

*) A footnote details limitations, if any.

Here is a summary of problem entities:

Broken Dimensions

Bricscad displays broken dimensions, but cannot create or edit them.

Dimensional Constraints 2010

Bricscad cannot display or create dimensional constraints (new to AutoCAD 2010); Bricsys plans to support
them in v10.1.

Dynamic Blocks

Bricscad treats dynamic blocks as regular blocks.

Geographic Location

Bricscad does not display, create, or edit geographic location markers.

Helix

Bricscad displays helixes, but cannot create them; helixes cannot be edited, except for moving, erasing, and
modifying basic properties (color, linetype, and so on).

Inspection Dimensions

Bricscad displays inspection dimensions, but cannot edit or create them.

Jogged Dimensions

Bricscad displays and edits jogged dimensions, but cannot create them.

Lights

Bricscad displays light objects and can modify their basic properties; it cannot create lights, nor does it use
AutoCAD lights in renderings.

Live Sections

Bricscad displays section planes, but objects are not sectioned; section planes cannot be edited, except for
moving, erasing, and modifying basic properties (color, linetype, and so on).

Multilines

Bricscad cannot create multilines, but can edit them with the Properties bar.

Multiline Leaders

Bricscad can neither create nor edit mleaders, but can edit their basic properties, such as color and layer; text
and arrowheads cannot be edited. Bricscad does not support multiline leader styles.
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Proxies

Bricscad displays proxy objects, but cannot edit them, except for their basic properties (color, linetype, and so
on). Bricscad does not support object enablers.

Subdivision Surfaces (3D mesh objects) 2010

Bricscad displays 3D mesh objects as proxies when AutoCAD 2010 drawings are saved in DWG 2007 format; the
proxies cannot be edited, except for their basic properties (color, linetype, and so on).

Surfaces

Bricscad recognizes surface objects created by AutoCAD, but cannot create surfaces. The surface objects
cannot be edited, except for their basic properties (color, linetype, and so on). Bricscad’s Extrude and Revolve
commands work only with closed objects, and so cannot create surfaces; Bricscad does not have the Loft and
Sweep commands.

Tables

Bricscad cannot create tables, but can edit some aspects of them with the Properties bar; text cannot be
edited.

Underlays

Bricscad does not display DGN, DWF, or PDF underlays.

Viewports

Bricscad cannot invert clipped viewports.

Newly Supported in Bricscad V10Newly Supported in Bricscad V10Newly Supported in Bricscad V10Newly Supported in Bricscad V10Newly Supported in Bricscad V10

Bricscad V10 now supports the following entities that were not supported in V9:

• New DimArc command dimensions the lengths of arc.

• New Field command creates and edits field text; the MText command now supports fields. New UpdateField
command forces updates of field data.
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DWG Object SupportDWG Object SupportDWG Object SupportDWG Object SupportDWG Object Support

To read, view, edit, and write DWG files, Bricscad uses the DWGdirect library from Open Design Alliance. As the
ODA adds support for entities, Bricsys is able to add them to Bricscad.

2D Entities Supported2D Entities Supported2D Entities Supported2D Entities Supported2D Entities Supported

Bricscad accurately displays the following 2D entities created in AutoCAD 2009:

Arcs AutoCAD Bricscad

Arc

Circles AutoCAD Bricscad

Circle

Ellipses AutoCAD Bricscad

Ellipse

Elliptical arc

Hatches AutoCAD Bricscad

Patterned

Solid filled

Gradient filled

Islands

Text detection

Lines AutoCAD Bricscad

Line
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Points AutoCAD Bricscad

PdMode 0     

PdMode 98

Polylines AutoCAD Bricscad

Segments

Arcs

Variable width

Fit-curved

Splined

Rays AutoCAD Bricscad

Rays

Solids (2D) AutoCAD Bricscad

3-sided

4-sided
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Splines AutoCAD Bricscad

Closed

Open

Traces AutoCAD Bricscad

Tracewid 50

Xlines AutoCAD Bricscad

Xlines

Basic Properties for EntitiesBasic Properties for EntitiesBasic Properties for EntitiesBasic Properties for EntitiesBasic Properties for Entities

Bricscad and AutoCAD support the same basic set of entity properties: color, layer, linetype, linetype scale, and
lineweight. Although it is not listed in its Properties bar, Bricscad also supports thickness.

Left: AutoCAD’s Properties palette.
Right: Bricscad’s Properties bar.

Bricscad supports ACI colors and True Colors, but not color books. All AutoCAD linetypes and lineweights are
supported. Other properties supported in common include elevation and plot style. Bricscad does not support
materials or shadows per entity.
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Text Entities SupportedText Entities SupportedText Entities SupportedText Entities SupportedText Entities Supported

Bricscad accurately displays the following text entities created in AutoCAD 2009:

Attribute Defs AutoCAD Bricscad

Text

Attribute Refs AutoCAD Bricscad

Attribute Refs

Multiline text

MText AutoCAD Bricscad

Mtext

Tables AutoCAD Bricscad * READ / — / PARTIAL EDIT

Tables

*) Bricscad cannot create tables, but can edit some aspects of them with the Properties bar; text cannot be edited.

Text AutoCAD Bricscad READ / — / PARTIAL EDIT

Text

Fields
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Tolerance AutoCAD * Bricscad

Tolerance

*) AutoCAD does not fully edit tolerance objects.

Text StylesText StylesText StylesText StylesText Styles

Bricscad supports all text style options with the exception of annotative scaling.

Above: AutoCAD’s Style dialog box.
Below: Bricscad’s Explorer for text styles.
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MText StylesMText StylesMText StylesMText StylesMText Styles

Bricscad supports many of AutoCAD’s mtext style options, but in a floating window that is less confusing than
AutoCAD’s ribbon.

Above: AutoCAD’s mtext editor.
Below: Bricscad’s mtext editor.

Table StylesTable StylesTable StylesTable StylesTable Styles

Bricscad supports the display and selection of styles for tables found in drawing files created in AutoCAD, but
cannot create or edit table styles. For instance, if the drawing has multiple table styles, you can change a table
from one style to another. The Properties bar illustrated below lists the limited properties of tables that
Bricscad can edit (white fields).
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Tolerance EditingTolerance EditingTolerance EditingTolerance EditingTolerance Editing

Bricscad supports all tolerance options. When it comes time to edit, however, AutoCAD displays the Properties
palette for limited editing, while Bricscad opens the Tolerance dialog box for complete editing.

Left: AutoCAD’s Properties palette for editing tolerance objects.
Right: Bricscad’s Tolerance dialog box.
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Dimension Entities SupportedDimension Entities SupportedDimension Entities SupportedDimension Entities SupportedDimension Entities Supported

Bricscad supports all of AutoCAD’s dimension entities, except for the dimensional constraint.

Aligned AutoCAD Bricscad

Aligned

Angular AutoCAD Bricscad

Angular

Arc Length AutoCAD Bricscad READ / — / —

Arc length

Diameter AutoCAD Bricscad

Diameter

DimBreak AutoCAD Bricscad * READ / — / —

Break

*) Bricscad displays broken dimensions, but cannot edit or create them.

DimConstraint AutoCAD 2010 Bricscad * — / — / —

Constraint NOT SUPPORTED

*) Bricscad cannot display or create dimensional constraints; Bricsys plans to support them in v10.1.
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DimInspect AutoCAD Bricscad * READ / — / —

Inspect

*) Bricscad displays inspection dimensions, but cannot edit or create them.

DimJogged AutoCAD Bricscad * READ / — / EDIT

Jogged

*) Bricscad displays and edits jogged dimensions, but cannot create them.

Ordinate AutoCAD Bricscad

X ordinate

Y ordinate

Radial AutoCAD Bricscad

Radial

Leaders AutoCAD Bricscad

Leader
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Multileaders AutoCAD Bricscad * READ / — / —

MLeaders

*) Bricscad can neither create nor edit mleaders, but can edit their basic properties bar, such as color and layer; text and
     arrowheads cannot be edited. Bricscad does not support multiline leader styles.

Dimension StylesDimension StylesDimension StylesDimension StylesDimension Styles

Bricscad supports all of AutoCAD’s dimension styles and variables, with the exception of annotative scaling and
text direction.

Left: AutoCAD’s DimStyle dialog box.
Right: Bricscad’s Explorer for dimensions.

Leader StylesLeader StylesLeader StylesLeader StylesLeader Styles

Bricscad’s support for leader styles is not as extensive as AutoCAD’s.

Left: AutoCAD’s QLeader command’s Settings dialog box.
Right: Bricscad’s Leader command’s options.
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Complex 2D Entities SupportedComplex 2D Entities SupportedComplex 2D Entities SupportedComplex 2D Entities SupportedComplex 2D Entities Supported

Block Refs AutoCAD Bricscad

Insert

Dynamic *

MInsert

Mirrored

Unequal Scale

*) Bricscad treats dynamic blocks as regular blocks.

Geographic AutoCAD Bricscad * — / — / —

Location NOT SUPPORTED

*) Bricscad does not display, create, or edit geographic location markers.
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Images AutoCAD Bricscad

Images

Clipped

Wipeouts

Lights AutoCAD Bricscad * READ / — / —

Light

*) Bricscad displays light objects and can modify their basic properties; it cannot create lights, nor can it use AutoCAD lights
     in renderings.

MLines AutoCAD Bricscad* READ / — / EDIT

Mlines

*) Bricscad cannot create multilines, but can edit them with the Properties bar.

OleFrames AutoCAD Bricscad

OleFrame
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Regions AutoCAD Bricscad

Region

Shapes AutoCAD Bricscad

Shape

Underlays AutoCAD Bricscad *

DGN

DWF

PDF NOT SUPPORTED

*) Bricscad does not display DGN, DWF, or PDF underlays. DGN image courtesy of Axiom Conversion Services; DWF
    image courtesy of Residential Drafting Services.
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Viewports AutoCAD Bricscad

Viewport

Clipped

Multiline StylesMultiline StylesMultiline StylesMultiline StylesMultiline Styles

Bricscad supports the display and selection of styles for multilines in drawings created in AutoCAD, but cannot
create or edit multiline styles. You can change a multiline from one style to another, if the drawing has more
than one multline style.
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3D Entities Supported3D Entities Supported3D Entities Supported3D Entities Supported3D Entities Supported

Bricscad accurately displays the following 3D entities created in AutoCAD 2009:

3D Faces AutoCAD Bricscad

3D face

Invisible edge

Helixes AutoCAD Bricscad * READ / — / —

Helix

*) Bricscad displays helixes, but cannot create them; helixes cannot be edited, except for moving, erasing, and modifying
       basic properties (color, linetype, and so on).

3D Polylines AutoCAD Bricscad

3D polyline

Polyface Meshes AutoCAD Bricscad

Mesh
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Proxy Objects AutoCAD Bricscad * READ / — / —

Proxy

*) Bricscad displays proxy objects, but cannot edit them, except for their basic properties (color, linetype, and so on).
     Bricscad does not support object enablers.

Sections AutoCAD Bricscad * READ / — / —

Live Section

*) Bricscad displays section planes, but objects are not sectioned; section planes cannot be edited, except for moving,
     erasing, and modifying basic properties (color, linetype, and so on).

3D Solids AutoCAD Bricscad

Body

Sweep
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Box

Cone

Cylinder

Pyramid

Sphere

Torus

Wedge
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Subdivisions AutoCAD 2010 Bricscad * READ / — / —

3D meshes

*) Bricscad displays 3D mesh objects as proxies when AutoCAD 2010 drawings are saved in DWG 2007 format; the proxies
     cannot be edited, except for their basic properties (color, linetype, and so on). Bricscad does not support object enablers.

Surfaces AutoCAD Bricscad READ / — / —

Extrude

Loft*

Revolve

Sweep *

*) Bricscad recognizes surface objects created by AutoCAD, but cannot create surfaces. The surface objects cannot be
     edited, except for their basic properties (color, linetype, and so on). Bricscad’s Extrude and Revolve commands work only
     with closed objects, and so cannot create surfaces; Bricscad does not have the Loft and Sweep commands.
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CHAPTERCHAPTERCHAPTERCHAPTERCHAPTER 4: 4: 4: 4: 4:

Customizing and
Programming

Bricscad

WHEREAS MOST OF AutoCAD’s customization takes place with the Cui and Options
commands, in Bricscad the activity takes place in the equivalent Customize and Set-
tings commands.

This chapter provides an overview of customizing and programming Bricscad; see the Cus-
tomizing Bricscad ebook for complete details on the topic (www.bricscad.com/estore).

For detailed information on programming Bricscad, refer to the online developer reference, available
free at www.bricsys.com/bricscad/help/en_US/V10/DevRef/index.html.
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Areas of Customization

Both AutoCAD and Bricscad provide a variety of customizing methods, centered primarily in the Options/

Settings and Cui/Customize commands:

Area of Customization AutoCAD Command Bricscad Command

Aliases ...1 Customize
Command bar Options Settings
Cursor Options Settings
Double-click actions Cui ...2

File paths Options Settings
Grips Options Settings
Hatch Patterns ...1 ...1

Keyboard shortcuts Cui Customize
Linetypes ...1 Explorer
Menu bar Cui Customize
Mouse buttons Cui ...
Plot Styles PlotStyle PlotStyle
Quick Access toolbar Right-click, Cui ...3

Quick Properties palettes Cui ...3

Ribbon Cui ...3

Rollover tooltips Cui ...3

Selection previews Options ...3

Shell commands ...1 Customize
Shortcut/Context menus Cui Customize
Status bar Right-click, Diesel Right-click, Diesel
Tablet Cui Customize
Tool palettes Customize ...3

Toolbars Cui Customize
UCS icon Options Settings
Workspaces Cui ...3

Notes:
1 Edit using Notepad.
2 Double-clicking entities opens the Properties palette (bar) in Bricscad.
3 Not available in Bricscad.

Cui vs CustomizeCui vs CustomizeCui vs CustomizeCui vs CustomizeCui vs Customize

The Bricscad equivalent to AutoCAD’s Cui command is Customize. It displays a dialog box that centralizes
customization of the following user interface elements:

• Menus

• Context menus (shortcut menus)

• Toolbars

• Keyboard shortcuts

• Tablet overlay menus and buttons
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• Command Aliases

• Shell Commands

The process for customizing most of these elements is identical. Learn the system for one element, such as
menus, and you can then handle any other, such as context menus, toolbars, shortcut keystrokes, and tablet
menus. Since the Bricscad method differs from AutoCAD’s, I show you below how to customize Bricscad by
using menus as the example.

You access the Customize dialog box through the Customize command, the Cui alias, or from the menu: Tools
| Customize. Alternatively, right-click any toolbar and then select Customize.

A couple of items to note:

Red dots prefix some menu items, as shown above. The dots indicate “container” items:

• BRICSCAD — names the menu group. This group includes Main Menus (items seen on the menu bar) and

Importing AutoCAD Menus

Bricscad’s Customize dialog box’s File | Load  item imports three kinds of menu files:

CUI — standard menu files used by AutoCAD (since release 2007) and Bricscad (since version 8).

MNU or MNS — legacy menu files used by AutoCAD and AutoCAD LT prior to release 2008.

ICM — IntelliCAD menu files used by Bricscad prior to version 8, as well as other CAD systems based on

IntelliCAD.

Careful: Although Bricscad imports AutoCAD menu files effortlessly, menu picks sometimes do not work,

because AutoCAD macros can contain macro code and metacharacters not supported by Bricscad.
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Context Menus (shortcut menus that appear when you right-click entities).

• Main Menus — names the items appearing on the menu bar.

 •    File — names the first menu appearing along the menu bar.

The rows of dashes “-----” indicate separator bars, the gray lines that separate groups of menu items.

MenusMenusMenusMenusMenus

Menus are customized in the Menu tab of the Customize dialog box. You can add, edit, and remove items to
and from menus. All you do is right-click an existing menu item, and then choose an option from the shortcut
menu. You can create new menus, add commands and sub-menus to existing menus, and add separator bars.

In this tutorial, you add the CloseAll command to the File menu after the Close item. (The CloseAll command
closes all open drawings.) To change the menu, follow these steps:

TIP Messed up the customization of Bricscad? Get everything back to the out-of-the-box look by clicking the Revert to
Defaults button at the bottom of the Customize dialog box.

1. Enter the Customize command to open the Customize dialog box.

2. In the dialog box, click the Menus tab.

About Copying Files

Autodesk permits the copying of support files, since the corporation understands that drawings are disabled

when DWG files are sent to clients without crucial support files. Support files that are coded in ASCII contain

the following notice from Autodesk:

Permission to use, copy, modify, and distribute this software for any purpose and without fee is
hereby granted, provided that the above copyright notice appears in all copies and that both that
copyright notice and the limited warranty and restricted rights notice below appear in all supporting
documentation.

By copying files in whole, you include the notices that Autodesk asks you to preserve.

TrueType Fonts

There is one exception. Some TrueType fonts (.ttf) are commercial products, and cannot be copied without

payment to the copyright holder. The good news, however, is that all TrueType fonts provided with Windows

and AutoCAD maybe copied freely. If a drawing contains copyrighted TrueType fonts, you can often find one

that look similar but cost nothing from font sites.
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3. The Main Menus node defines the structure of the currently-loaded menu. The names in the dialog box, like
File, Edit, and so on, match the names on Bricscad’s menu bar.

4. Click the + next to File to reveal the items in the File dropdown menu, as illustrated below.

Left: File menu tree in Customize dialog box.
Right: Menu items under the File menu.

5. Right-click the ----- (separator) item below Close. Notice that Bricscad displays a shortcut menu.

1. Open File item

2. Right-click ------ item
3. Choose Insert Item

6. Choose Insert Item. This adds the new item above the currently-selected one, ------.

TIP The  Append Item and Insert Item options seem similar; here’s how they differ:
Append Item —  adds the new item at the end of the File container.
Insert Item — adds the new item before the currently selected item.
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7. Notice that Bricscad opens the Add Menu Item dialog box. It lists all of the commands available in Bricscad.
You can select an existing command or create a new one.

(Alternatively, you could have right-clicked File and then chosen Append Item. The drawback to this approach
is that the CloseAll command is added to the end of the File menu, which leads to the extra step of moving
CloseAll into position under Close.)

1. Choose this option

2 Select an available tool
(command)

3. Click OK.

Command parameters
filled in for you

a. In the Add Menu Item dialog box, choose the Select Available Tool option. This allows you to pick
one of Bricscad’s built-in commands. (The other option, Create New Tool, is for creating new com-
mands.)

b. Under the list of Available Tools, open the File item, and then choose Close All. Notice that most of
the parameters are filled in for you, such as Title, Help, and so on.

c. Click OK.

Notice that the Close All command is added to the list under Close.

Left: CloseAll added to menu tree.
Right: Close All appearing in File Menu.
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8. To ensure the new command works, follow these steps:

a. Close the Customize dialog box by clicking OK.

b. Choose the File menu. Notice that the Close All item has been added.

c. Click Close All. Does it work correctly? (It should prompt you to save all open drawings that have
changed since being loaded.)

TIPS Not sure which commands can be added to menus? Peruse the list found under Available Tools in the Customize
dialog box. It lists all the commands found in Bricscad, sorted by menu order.

The Available Tools listing allows you to add your own commands, which can be constructed from other commands and
LISP routines.

Creating New Menu ItemsCreating New Menu ItemsCreating New Menu ItemsCreating New Menu ItemsCreating New Menu Items

You can add new commands and macros to Bricscad, which it calls “tools.” The following tutorial shows you
how this is done in Bricscad. The tutorial creates a tool that consists of a macro for saving the current drawing
and then starting the Plot command. The macro will be named “Save’n Print” and looks like this:

^C^C_qsave;_plot

1. Open the Customize dialog box with the Customize command. (Alternatively, you can enter its alias, Cui.)

2. In the Menus tab’s File item, right-click Print, and then choose Insert Item from the shortcut menu.

3. Notice the Add New Item dialog box. Select the Create New Tool option.

1. Choose this option

2. Enter parameters

3. Click OK.
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4. Fill in the parameters listed below:

Parameter Entry Notes

Toolbox File Adds the new command to the File category of available tools.
Title Save‘n Print Specifies the name that appears in the File menu.
Help Saves the drawing, and then Specifies the Help text that appears on the status bar.

starts the Plot command.
Command ^C^C_qsave;_plot Specifies the macro that cancels the current command, saves

the drawing, and then starts the Plot command.
Image (leave blank) Specifies the icon; none are required for menus.

5. Click OK to exit the Add Menu Item dialog box.

Notice that the new tool is added to the File menu (on the left), as well as to the list of Available Tools (on the
right). In addition, its parameters are shown in the Menu Item pane at the bottom of the dialog box. (You can
edit the parameters here, just as with regular commands.)

New tool added here And here

New tool's parameters

6. Click OK to exit the Customize dialog box.

7. Test the new item by selecting Save’n Print from the File menu.

Macro MetacharactersMacro MetacharactersMacro MetacharactersMacro MetacharactersMacro Metacharacters

Menu items execute macros, which can contain metacharacters. Bricscad and AutoCAD use many of the same
metacharacters. Since they are so similar, I’ll list them briefly:

Metacharacter Notes

^C Cancels the current command.
' Executes the command transparently.
_ Internationalizes the command.
; Executes Enter.
\ Pauses the macro.
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Menu Design ConventionsMenu Design ConventionsMenu Design ConventionsMenu Design ConventionsMenu Design Conventions

Bricscad and AutoCAD use many of the same conventions for designing menus, as summarized below:

& — designates shortcut keystrokes for accessing menu items with the Alt key.

... — indicates the menu item will display a dialog box.

DieselDieselDieselDieselDiesel

AutoCAD and Bricscad can employ same Diesel in menu macros and LISP routines.

Context MenusContext MenusContext MenusContext MenusContext Menus

Bricscad called shortcut menus “context menus,” because they change their content depending on the con-
text. Context menus are found in the Menus tab, just past the Main Menus section. The screengrab (below) lists
the context menus provided by default in Bricscad.

Right-clicking a selected entity displays the default context menu (“Edit” in the list above). The Bricscad version
is shown with that of AutoCAD for comparison:

Left: AutoCAD’s default shortcut menu for editing objects.
Right: Bricscad’s equivalent context menu.
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The matching of menu items to customization nodes is straightforward:

Left: Bricscad’s Edit context menu.
Right: Defining the menu in the Customize dialog box.

ToolbarsToolbarsToolbarsToolbarsToolbars

Toolbars are customized in the Toolbar tab. The screengrab (below) lists the names of toolbars provided by
Bricscad.

The Bricscad version of the Standard toolbar is shown with that of AutoCAD for comparison:

Top: AutoCAD’s Standard toolbar.
Above: Bricscad’s equivalent toolbar.



chapter 4 • Customizing and Programming Bricscad 6565656565

Customizing toolbars is identical to customizing menus, with two exceptions: submenus are called “flyouts,”
and toolbars can contain controls, another name for droplists. The figure below shows how the Standard tree
matches the Standard toolbar.

Left: Content of the Standard tree in Bricscad.
Right: Icons of the Standard toolbar.

As in AutoCAD, you can specify the initial location of toolbars:
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Keyboard ShortcutsKeyboard ShortcutsKeyboard ShortcutsKeyboard ShortcutsKeyboard Shortcuts

Keyboard shortcuts are customized in the Keyboard tab, as illustrated by the screengrab below. Bricscad has
many of the same shortcuts as AutoCAD. Appendix D contains a useful cross-reference of shortcuts for both
programs.

Tablet Buttons and MenusTablet Buttons and MenusTablet Buttons and MenusTablet Buttons and MenusTablet Buttons and Menus

Tablet overlay menus and digitizer buttons are customized in the Tablet tab, as illustrated below.

Bricscad provides an overlay menu layout that is similar to that of AutoCAD.
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Unlike for mouse buttons, digitizer buttons can be customized by Bricscad, as illustrated below.

As in AutoCAD, the first button cannot be changed, because it must always be the pick button.

Aliases and Shell CommandsAliases and Shell CommandsAliases and Shell CommandsAliases and Shell CommandsAliases and Shell Commands

Command aliases are customized in the Aliases tab, as illustrated below. Bricscad has many of the same aliases
as AutoCAD. Appendix C contains a useful cross-reference of aliases for both programs.

Bricscad and AutoCAD both use the .pgp file for storing command aliases and shell commands.

CAD Program Default PGP File Default  Path

AutoCAD acad.pgp C:\Users\<login>\appdata\roaming\autodesk\autocad 2010\r18.0\enu\support
Bricscad default.pgp C:\Users\<login>\AppData\Roaming\Bricsys\Bricscad\V10\en_US\support

If you have customized your acad.pgp file, you can load it into Bricscad.
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Program Parameter File — allows you to load the acad.pgp file provided with AutoCAD (found in
C:\Users\<login>\appdata\roaming\autodesk\autocad 2010\r18.0\enu\support).

Add — adds a new shell command; Bricscad uses the same format AutoCAD.

Edit — edits the selected shell command.

Delete — erases the selected shell command.

Shell CommandsShell CommandsShell CommandsShell CommandsShell Commands

Shell commands are customized in the Shell Commands tab, as illustrated below.

Add — adds a new shell command; Bricscad uses the same format AutoCAD.
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Other CustomizationsOther CustomizationsOther CustomizationsOther CustomizationsOther Customizations

FontsFontsFontsFontsFonts

AutoCAD and Bricscad use the same font files: TrueType (.ttf) and compiled shapes (.shx). AutoCAD also
supports PostScript (.pfb) fonts indirectly through the Compile command, which converts PostScript fonts to
SHX format; Bricscad does not work with PostScript fonts.

This means Bricscad can use any font that you’ve employed in your AutoCAD drawings. Since Windows con-
trols TrueType fonts, there is no need to copy any .ttf files to Bricscad; they are all stored in the \windows\fonts
folder for use by all Windows programs.

AutoCAD keeps its SHX fonts in the \Program Files\AutoCAD 2010\Fonts folder. To use them with Bricscad,
you can copy the files between folders.

Font MappingFont MappingFont MappingFont MappingFont Mapping

Bricscad and AutoCAD support font mapping, handy when fonts are missing from your drawing. Both use the
same two system variables:

FontAlt — specifies the name of the font to use when the correct one cannot be found. Both CAD systems
use simplex.shx as the default replacement font.

FontMap — specifies the file name of the file to map alternative font names:

CAD System FontMap Default Folder

AutoCAD acad.fmp C:\Users\<login>\AppData\Roaming\Autodesk\AutoCAD 2010\R18.0\enu\Support
Bricscad default.fmp C:\Users\<login>\AppData\Roaming\Bricsys\Bricscad\V10\en_US\support

Both CAD systems use the same format of font mapping file, so you can copy it from AutoCAD. Here are the
first five mappings from default.fmp:

ic-comp;complex.shx
ic-complex;complex.shx
ic-gdt;gdt.shx
ic-ital;italic.shx
ic-italc;italicc.shx

Linetypes and Hatch PatternsLinetypes and Hatch PatternsLinetypes and Hatch PatternsLinetypes and Hatch PatternsLinetypes and Hatch Patterns

Bricscad and AutoCAD use the same definitions for linetypes and hatch patterns. Both simple and complex
linetypes are defined by .lin files, while hatch patterns are defined by .pat files. The default names are as
follows:

File Type AutoCAD Default Bricscad Default Notes

Linetypes acad.lin default.lin
acadiso.lin iso.lin ISO-standard linetypes

Hatch patterns acad.pat default.pat
acadiso.pat iso.pat ISO-standard hatch patterns

This means that in Bricscad you can use linetypes and hatch patterns customized for AutoCAD. Copy the files
from AutoCAD’s support folder:

C:\Users\<login>\AppData\Roaming\Autodesk\AutoCAD 2010\R18.0\enu\Support
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to the Bricscad support folder:

C:\Users\<login>\AppData\Roaming\Bricsys\Bricscad\V10\en_US/Support

Or, use Bricscad to access the AutoCAD linetype files, as follows:

1. Use the Linetype command to open the Explorer window at the Linetypes node.

2. Click the New button to display the Load Linetypes dialog box.

3. Click File to access another .lin file, such as acad.lin.

4. Navigate to C:\Users\<login>\AppData\Roaming\Autodesk\AutoCAD 2010\R18.0\enu\Support, and then
choose the .lin file you wish to open. Replace <login> with your Windows login name.

5. Click Open.
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Plot StylesPlot StylesPlot StylesPlot StylesPlot Styles

Bricscad and AutoCAD support both color-based and style-based plot styles, which allows entities to look
different when plotted.

Plot Style File Notes

STB Style-based plot style table (newer style)
CTB Color-based plot style table (older style)

To create and edit plot styles in Bricscad, choose Plotstyle Manager from the File menu, or enter the PlotStyle
command. The figures below show that style-based plot style tables of both CAD programs are almost identi-
cal:

Left: AutoCAD’s STB table.
Right: Bricscad’s STB table.

The sole difference is the name of default style table files. AutoCAD’s default is acad.stb, while Bricscad’s
default is default.stb. This means Bricscad can use STB and CTB files created in AutoCAD.

Plotter ManagerPlotter ManagerPlotter ManagerPlotter ManagerPlotter Manager

Bricscad and AutoCAD both support PC3 plotter manager files, which allow users to customize plotter options.
Thus, Bricscad can use PC3 files created in AutoCAD.

To create and edit plotters in Bricscad, choose Plotter Manager from the File menu, or enter the
PlotterManager command. The figures below show that the plotter configuration editors of both CAD pro-
grams are similar:
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Left: AutoCAD’s plotter editor.
Right: Bricscad’s plotter editor.

Options vs SettingsOptions vs SettingsOptions vs SettingsOptions vs SettingsOptions vs Settings

Bricscad and AutoCAD provide extensive options for controlling the CAD drafting environment, from modify-
ing the look of the user interface to specifying the names of project folders. These settings are mostly stored
in system variables; some are also stored in data files, environment variables, and the Windows registry.

AutoCAD’s primary interface for program settings is the dialog box displayed by the Options command, which
provides users with access to many — but not all — system variables. The equivalent in Bricscad is the Settings
command’s dialog box; in contrast to AutoCAD, it provides you with access to all system variables. See Chapter
2 for details on using the Settings dialog box.

Both CAD programs also employ the command-line-oriented SetVar command for direct access to system
variables.

File PathsFile PathsFile PathsFile PathsFile Paths

In addition to the core DWG drawing file, Bricscad and AutoCAD use many support files. In older, simpler
times, support files were simply stored in a folder named \Support. But as Microsoft made Windows more
complex, support files became scattered throughout computer hard drives — and sometimes not even on the
computer you use.

The complexity stems from networking. Different support files need to be handled differently:

Local files — stored on the computer you use; these files are specific to each user and each CAD program,
such as DWG drawing files and local customization files.

Common files — stored on the computer you use; these files are common to many programs, such as fonts
and printer drivers.

Temporary files — stored “anywhere,” locally or on the network; these files are created by CAD programs  for
the duration of the editing session, such as automatic backup files.
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Roaming files — stored on any computer;  these files are specific to you, and that can be accessed from any
networked computer, such as linetypes and hatch patterns. See Roamable Profiles later in this chapter.

Network files — stored on the network and accessible to everyone; these files are meant to be shared by
everyone, such as blocks and templates.

Both CAD programs let you specify the paths to these folders. In AutoCAD, paths are specified in the Files tab
of the Options dialog box. In Bricscad, paths are specified in the Program Options section of the Settings dialog
box.

Above: AutoCAD’s Files tab.
Below: Bricscad’s Files nodes.
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User ProfilesUser ProfilesUser ProfilesUser ProfilesUser Profiles

Bricscad and AutoCAD support user profiles, which store your customization settings for each CAD program.
After changing settings with the Options (AutoCAD) or Settings (Bricscad) commands, you can save them to an
.arg user profile file. This allows you to create multiple profiles, each for a different user or different project.

You can launch Bricscad with a user profile by adding the /P switch to its desktop shortcut. (Right-click the shortcut
icon on the desktop, and then choose Properties from the shortcut menu.) Edit the Target text like this:

"C:\Program Files\Bricsys\Bricscad V10\bricscad.exe" /P /P /P /P /P <UserProfileName>

In AutoCAD, user profiles are created and accessed through the Profiles tab of the Options dialog box. In
Bricscad, user profiles are generated through a separate application, UserProfileManager.exe.

Left: AutoCAD’s user profiles facility
Right: Bricscad’s user profiles application.

Because both programs use the same .arg file format, you can import AutoCAD-generated profiles into Bricscad
by following these steps.

In AutoCAD:

1. In AutoCAD, enter the Options command, and then click on the Profiles tab. See figure above.
2. Choose a profile from the list, and then click Export.
3. Select a folder in which to save the profile file, and change the file name, if you wish. Click Save.
4. Click OK to exit the dialog box.

In Bricscad:

1. In Bricscad, from the Tools menu, choose User Profile Manager. See figure above.
2. In the User Profile Manager, click Import.
3. Choose the .arg file exported from AutoCAD, and then click Open.
4. To apply the profile, click Set Current.
5. Click OK to exit the program.

Roaming ProfilesRoaming ProfilesRoaming ProfilesRoaming ProfilesRoaming Profiles

Bricscad and AutoCAD support roaming profiles, which let you “roam” about the office and use the CAD
software (customized with your settings) on any computer connected to the office network. Your settings are
identified automatically by your login name, which you enter when you access a computer.
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Not all CAD-related files are roamable; some remain local, such as DWG drawings and CUI. Roamable and
nonroamable files are kept in different folders, whose names vary depending on the variant of Windows
running on your computer. For Vista, these are:

AutoCAD’s roamable files:
C:\Users\<login>\AppData\RoamingRoamingRoamingRoamingRoaming\Autodesk\AutoCAD 2010\R18.0\enu

• Data links

• Language packs

• Migration

• Plot styles (CTB, STB), plotter parameters (PMP), and plotter configurations (PC3)

• Support files (CUIX, FMP, LIN, MLN, MNL, PAT, PGP, PSF, UNT, and so on).

AutoCAD’s nonroamable files:
C:\Users\<login>\AppData\LocalLocalLocalLocalLocal\Autodesk\AutoCAD 2010\R18.0\enu

• Template files (DWT, DST, DGN)

• Web Services

Bricscad’s roamable files:
C:\Users\<login>\AppData\RoamingRoamingRoamingRoamingRoaming\Bricsys\Bricscad\V10\en_US

• Plot styles (CTB, STB), and plotter configurations (PC3)

• Support files (CUI, FMP, LIN, PAT, PGP, PSF, UNT, and TXT).

Bricscad’s nonroamable files:
C:\Users\<login>\AppData\LocalLocalLocalLocalLocal\Bricsys\Bricscad\V10\en_US

• Template files (DWT)

TIP You can change the path to the local and roamable folders with the related system variables LocalRootPrefix and
RoamableRootPrefix.

Accessing Hidden FoldersAccessing Hidden FoldersAccessing Hidden FoldersAccessing Hidden FoldersAccessing Hidden Folders

The local and roaming folders can be difficult to find, because they are typically hidden by Windows, unfortu-
nately. Here are  some ways to access hidden folders:

• Make all hidden folders visible through Start | Control Panel | Folder Options | View tab |  Show Hidden
Files and Folders. (You can also access the dialog box through the Tools menu, if menus are turned on for
Explorer.)

• Or, copy (Ctrl+C) the folder path from this book, and then paste it (Ctrl+V) into the address bar of Explorer.

• Or, create shortcuts on your computer’s desktop to the hidden folders: hold down Ctrl+Alt while dragging the
folder name from Explorer onto the desktop.
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Supported FilesSupported FilesSupported FilesSupported FilesSupported Files

In addition to DWG drawing files, Bricscad and AutoCAD employ many additional files. The following tables
cross-reference supported files by extension between the two CAD packages.

AutoCAD File Bricscad File Notes

Drawing Files
.adt .adt Audit log files
.bak .bak Backup drawing files
.dwf .dwf Design Web format files
.dwfx ... XPS compatible version of DWF files
.dwg .dwg Drawing files
.dws ... CAD standards files
.dwt .dwt Drawing template files
.dxb ... Binary drawing interchange files for CAD/camera
.dxf .dxf Drawing interchange files, ASCII and binary
.sv$ .sv$ Autosaved drawing files
.xlg .xlg Xref log files
.$$$ ... Emergency backup files
.$ac ... Temporary files created by AutoCAD
.$a ... Temporary files

Support Files
.acb ... AutoCAD color book files
.acl ... Autocorrect list files
.arg .arg User profile files
.atc ... AutoCAD tool catalog files
.aws ... AutoCAD workspace files
.blk ... Block template files
.cfg .cfg Configuration files
.chm chm Compiled HTML format help files
.chx ... Standards check files
.css ... Cascading style sheet files
.cui .cui Customize User Interface files
.cuix ... Customization container files
.cus .cus Custom dictionary files
.dbq ... Database query files
.dbt ... Database template files
.dbx ... Database extension files
.dct .dic Dictionary files
.dsd ... Drawing set description files
.dst ... Sheet set data files
.err ... Error log files
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.fdc ... Field catalog files

.fmp .fmp Font mapping files

.hdi ... Heidi device interface files

.hlp .hlp Windows-format help files

.htm, .html .htm, .html Hypertext markup language files

... .icm IntelliCAD menu files

.ies ... Illumination distribution data files

.ini ... Configuration (initialization) files

.lin .lin Linetype definition files

.log .log Log files created by the LogFileOn command

... .lwi Base material files

.mli ... Material library files for rendering

.mln ... Multiline style files

.mnc ... Compiled menu files (deprecated as of AutoCAD 2006)

.mnd ... Uncompiled menu files containing macros (deprecated)

.mnl ... AutoLISP routines used by AutoCAD menus (deprecated)

.mnr ... Menu resource files

.mns .mns AutoCAD-generated menu source files (deprecated)

.mnu .mnu Menu source files (deprecated as of AutoCAD 2006)

.nfl ... Filter list files

.pat .pat Hatch pattern definition files

.ptw ... Publish to Web settings files

.pwt ... Publish to Web template files

.rml ... Redline markup files (obsolete)

.shp ... Shape and font definition files

.shx .shx Compiled shape and AutoCAD font files

.slg ... Status log files

.ttf .ttf Microsoft font files

.txt .txt Text message files

.udl ... Microsoft data link files

.xml ... Extended markup language files

.xmx ... External message files

.xpg ... XML-format tool palette group files

Plotting Support Files
.ctb .ctb Color-table based plot parameter files
.pc2 ... Plot configuration parameters files for AutoCAD 2000 (deprecated)
.pc3 .pc3 Plot configuration parameters files since AutoCAD 2000i
.pcp ... Plot configuration parameters files for AutoCAD R14 (deprecated)
.plt .plt Plot files
.pmp .pmp Plotter model configuration files
.pss ... Plot stamp settings files
.stb .stb Style-table based plot parameter files

AutoCAD File Bricscad File Notes
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Import-Export Files
.3ds ... 3D Studio files
.bmp .bmp Windows raster files (device-independent bitmap)
.cdf .cdf Comma delimited files
.dgn ... MicroStation V8 and V7 design files
.dxe ... Data extraction files created by DataExtraction command
.dxx ... DXF files created by AttExt command
... .emf Enhanced metaformat files
.eps ... Encapsulated PostScript files
.fax ... Fax raster plot files
.fit ... FIT raster plot files
.gif .gif CompuServe image files
.jpg, .jpeg .jpg, .jpeg Joint photographic expert group files
... .jp2 JPEG 2000 files
.kml ... Google Earth files (keyhole markup language)
.kmx ... Compressed KML files
.pcx .pcx Raster format files
.pdf .pdf Portable document format files
.png .png Portable Network Graphics raster files
.sat .sat ACIS solid object files (short for “Save As Text”) files
.sdf .sdf Space-delimited files
... .sid MrSID geospatial imagery format from LizardTech
.slb .slb Slide library files
.sld .sld Slide files
.stl ... Solid object stereo-lithography files
.tga .tga Raster format (Targa) files
.tif .tif Raster format (Tagged image file format) files
.txt .txt Space delimited files
.wmf .wmf Windows metaformat files
.xls ... Excel spreadsheet files

API and Programming Files
.actm ... Active macro source code files
.arx ... AutoCAD runtime extension files
... .brx Bricsys runtime extension files
.cpp .cpp ObjectARX source code files
.dce .dce Dialog error log files
.dcl .dcl Dialog control language descriptions of dialog boxes
... .drx Design runtime extension files
.dll .dll Dynamic link libraries
.dvb .dvb Visual Basic for Applications program files
.fas ... AutoLISP fast load programs files

AutoCAD File Bricscad File Notes
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.h .h ADS/SDS and ARX/BRX/DRX function definition files

.lib .lib ARX BRX/DRX function library files

.lsp .lsp AutoLISP/LISP program files

... .mcr Macro files

.pgp .pgp Program parameters files (external commands and aliases)

.rx ... Lists of ARX applications that load automatically

.scr .scr Script files

.unt unt Unit definition files

... .vbi VBA project files prior to Bricscad V8

.vlx ... Compiled Visual LISP files

AutoCAD File Bricscad File Notes
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Programming ConsiderationsProgramming ConsiderationsProgramming ConsiderationsProgramming ConsiderationsProgramming Considerations

Bricsys makes it easy for you to transfer your AutoCAD add-ons to Bricscad by supporting almost the same list
of programming languages and APIs as does AutoCAD:

AutoCAD API Bricscad Equivalent Notes

Programming Languages
AutoLISP LISP AutoLISP code runs as-is in Bricscad; check (command statements)
Diesel Diesel Diesel code runs as-is in Bricscad, no changes needed
VBA VBA AutoCAD VBA code runs as-is in Bricscad, no changes needed
VSTA ... Unavailable in Bricscad

APIs
DCL DCL DCL code runs as-is in Bricscad, no changes needed
ADS SDS ADS code requires only a recompile using SDS headers
ARX BRX ARX code requires only a recompile using BRX headers

DRX DRX requires careful checking of the ARX code.
COM COM AutoCAD COM code runs as-is in Bricscad, no changes needed
.Net DWGdirect.NET .Net will be supported by Bricscad in a future release
(Managed wrapper classes)

Generally Bricscad provides a nearly identical subset of equivalent function names. In the case of non-com-
piled code, such as LISP and DCL, you just drop it into the Bricscad environment. For compiled code, you
recompile using the headers provided by Bricsys.

API is short for "application programming interface," and is the software link between Bricscad and program-
ming languages/compilers.

TIP Detailed information is freely available from the Bricsys online developer reference at www.bricsys.com/bricscad/help/
en_US/V9/DevRef.

Porting AutoLISP to LISPPorting AutoLISP to LISPPorting AutoLISP to LISPPorting AutoLISP to LISPPorting AutoLISP to LISP

Most AutoLISP routines work directly in Bricscad. Its LISP engine supports VL, VLA functions, and LISP reactors;
it does not support compiling to FAS (compiled LISP) files.

You may experience the following issues:

• Bricscad’s command line input can vary slightly from AutoCAD. The solution is to verify the content of all
(command) functions. Or avoid the use of (command) altogether.

• Bricscad does not implement a few AutoLISP functions. The solution is to rewrite the code, or adapt external
libraries.

DOSLib works with Bricscad Pro. It is a free library of LISP-callable functions not found in regular LISP. See
en.wiki.mcneel.com/default.aspx/McNeel/DOSLib.html.
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Porting DCL to BricscadPorting DCL to BricscadPorting DCL to BricscadPorting DCL to BricscadPorting DCL to Bricscad

Most DCL routines work directly in Bricscad. OpenDCL support is in alpha testing (at time of writing).

Porting Diesel to BricscadPorting Diesel to BricscadPorting Diesel to BricscadPorting Diesel to BricscadPorting Diesel to Bricscad

Most Diesel routines work directly in Bricscad.

Porting VBA to BricscadPorting VBA to BricscadPorting VBA to BricscadPorting VBA to BricscadPorting VBA to Bricscad

AutoCAD and Bricscad both use DVB files for VBA projects. Releases of Bricscad older than V8 use VBI files,
which can be converted to VBA. Refer to the VBA conversion tool at www.bricsys.com/common/vbaconversion.

Porting ADS to SDSPorting ADS to SDSPorting ADS to SDSPorting ADS to SDSPorting ADS to SDS

To make ADS programs work with SDS in Bricscad, follow these steps:

• Replace the Ads_ prefixes of function names by Sds_.

• Replace AdsLib.h with Sds.h as the include file.

• Visual C projects should be set up to produce DLLs. (These are loaded into Bricscad with the XLload command
or through Tools | Load LISP or SDS Application.)

Since ADS/SDS were developed nearly 20 years ago, Bricsys considers SDS deprecated, meaning developers
should no longer use it.

Porting ARX to BRXPorting ARX to BRXPorting ARX to BRXPorting ARX to BRXPorting ARX to BRX

The BRX SDK (Bricscad runtime extension software development kit) is code-compatible with ARX (AutoCAD
runtime extension), so there is no need to convert your code. Your application must be compiled with Visual
Studio 2005 SP1, or any higher version  compatible with version 8.0 of Microsoft’s CRT and MFC libraries.

Porting ARX to DRXPorting ARX to DRXPorting ARX to DRXPorting ARX to DRXPorting ARX to DRX

Bricsys recommends that you use its own BRX SDK, rather than the DRX SDK (DwgDirect runtime extension)
from the Open Design Alliance, because

• BRX does not require any code conversion.

• BRX supports advanced topics, such as custom objects and entities.

DRX has the following differences from ARX:

DRX enforces the use of smart pointers in client code.

DRX’s method of constructing and destructing objects is different from that of ARX.

DRX’s control flow of error handling is different from that of ARX applications.

DRX SDK contains a subset of ARX functionality; editor-related ARX interfaces are missing.

DRX has minor differences in the class hierarchy of objects.

DRX is available to members of the OpenDesign Alliance at www.opendesign.com.
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Porting COM to BricscadPorting COM to BricscadPorting COM to BricscadPorting COM to BricscadPorting COM to Bricscad

COM (Common Object Model) is available in both the Standard and Pro versions of Bricscad. (Only VBA is not
found in the Standard version.) The COM object model is accessed through programming languages like VB,
VBA, and C++.

Though Bricscad object model is quite similar to AutoCAD’s, it is not identical. Most VB/VBA code written for
AutoCAD should work directly under Bricscad. When you find a required element missing from the object
model, the Bricscad developer support team is open to creating a priority build that adds the functions you
require.

Bricscad does not support VSTA (Visual Studio Tools for Applications).

UnitsUnitsUnitsUnitsUnits

Bricscad and AutoCAD share the same units conversion file, which is used by LISP, SDS, and other functions.
Bricscad calls its file default.unt, while AutoCAD’s is acad.unt.

Loading Applications into BricscadLoading Applications into BricscadLoading Applications into BricscadLoading Applications into BricscadLoading Applications into Bricscad

Bricscad and AutoCAD both use the AppLoad command to load applications.

Left: AutoCAD’s application loader.
Right: Bricscad’s application loader.

TIP The RecScript command (script recorder) in Bricscad produces .scr files that can be edited, which makes it more
useful than the Action Recorder in AutoCAD.
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Third-party Developer SupportThird-party Developer SupportThird-party Developer SupportThird-party Developer SupportThird-party Developer Support

Bricsys notes that “There is day to day support for application developers who need assistance porting appli-
cations to Bricscad V9 or V10, or simply require technical information about the porting process and the
possibilities. The Bricsys development team has an extended section with dedicated developers for the differ-
ent development environments (LISP, COM, ADS, ARX).”

TIP  Bricsys does not charge third-party developers, unlike CAD vendors. There is no fee to join, no annual membership,
no charge for support, and no royalties on shipping products. Visit www.bricscad.com/en_INTL/home/developers.jsp for
more information and to register as a third-party developer.

When third-party developers request an addition to the API, it also becomes a new feature in Bricscad that
end-users can employ.
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Bricscad Object ModelBricscad Object ModelBricscad Object ModelBricscad Object ModelBricscad Object Model
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APPENDIXAPPENDIXAPPENDIXAPPENDIXAPPENDIX     AAAAA:::::

AutoCAD-Bricscad
Command

Cross-reference

THIS APPENDIX LISTS the commands found in AutoCAD 2010 and Bricscad
V10. The list is sorted alphabetically by command name. Not included are un-
documented commands, hardwired aliases, or deprecated commands.

2010 indicates the command is new to AutoCAD 2010

V10 indicates the command is new to Bricscad V10
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AutoCAD Command Bricscad Command Notes

AAAAA

About About
AcisIn AcisIn
AcisOut AcisOut
2010 ActBasepoint ...
2010 ActManager ...
ActRecord ... Equivalent Bricscad command: RecScript
ActStop ... Equivalent Bricscad command: RecScript
ActUserInput ...
ActUserMessage ...
AdCenter ... Equivalent Bricscad: Explorer
AdcClose ...
AdcNavigate ...

AddInMan Bricscad VBA COM Add-In Manager
2010 Adjust ... Equivalent Bricscad: ImageAdjust
Ai_Box Ai_Box
Ai_Cone Ai_Cone
Ai_Dish Ai_Dish
Ai_Dome Ai_Dome
Ai_Mesh ... Equivalent Bricscad: Mesh
Ai_Pyramid Ai_Pyramid
Ai_Sphere Ai_Sphere
Ai_Torus Ai_Torus
Ai_Wedge Ai_Wedge
Align Align
AllPlay ...
AmeConvert ...
AniPath ...
AnnoReset ...
AnnoUpdate ...
Aperture Aperture
... Apparent AutoCAD equivalent: -Osnap Apparent
AppLoad AppLoad
Arc Arc
Archive ...
Area Area
Array Array
Arx ... Equivalent Bricscad: AppLoad
2010 Attach ... Equivalent Bricscad: ImageAttach, Xref
AttachURL ... Equivalent Bricscad: Hyperlink
AttDef AttDef
AttDisp AttDisp
AttEdit AttEdit
AttExt AttExt
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AttIPedit ...
AttRedef ...
AttSync ...
Audit Audit
2010 AutoConstrain ...
AutoPublish ...

BBBBB

Base Base
BAttMan ...
BEdit ...
2010 BESettings ...
BHatch BHatch
Blipmode Blipmode
Block Block
BlockIcon ... Required by AutoCAD for old drawings
BmpOut BmpOut
Boundary Boundary
Box Box
Break Break
BRep ...
Browser Browser

CCCCC

Cal Cal Bricscad displays Windows Calculator
Camera ...
... Center AutoCAD equivalent: -Osnap Center
Chamfer Chamfer
Change Change
CheckStandards ...
ChProp ChProp
ChSpace ...
Circle Circle
ClassicImage ... Equivalent Bricscad: Image
ClassicLayer ... Equivalent Bricscad: Layer
ClassicXref ... Equivalent Bricscad: Xref
CleanScreenOn ...
CleanScreenOff ...
2010 Clip ... Equivalent Bricscad: XClip, ImageClip
Close Close
CloseAll CloseAll
Color Color
CommandLine CommandLine

AutoCAD Command Bricscad Command Notes
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CommandLineHide CommandLineHide
Compile ... Required only for converting PostScript font files
Cone Cone
2010 ConstraintBar ...
2010 ConstraintSettings ...
Convert ... Required only for old AutoCAD drawings
ConvertCTB ConvertCTB
ConvertOldLights ... Required only for old AutoCAD drawings
ConvertOldMaterials ... Required only for old AutoCAD drawings
ConvertPStyles ...
ConvToSolid ...
ConvToSurface ...
Copy Copy
CopyBase CopyBase
CopyClip CopyClip
... CopyEData Copies xdata between entities
CopyHist CopyHist
CopyLink ...
CopyToLayer ...
CUI ... Equivalent Bricscad: Customize
CuiExport ...
CuiImport ...
CuiLoad CuiLoad
CuiUnload CuiUnload
CustomerInvolvementProgram ...
Customize Customize Bricscad equivalent to CUI command.
CutClip CutClip
Cylinder Cylinder

DDDDD

DataExtraction ...
DataLink ...
DataLinkUpdate ...
DbConnect ...
DbClose ...
DbList DbList
... DdAttE AutoCAD equivalent: AttEdit
... DdEdit Renamed EditText in AutoCAD 2010
... DdEModes Bricscad displays Settings dialog box
... DdFilter Bricscad displays Settings dialog box
... DdGrips Bricscad displays Settings dialog box
DdPtype DdPtype Bricscad displays Settings dialog box
... DdSelect Bricscad displays Settings dialog box

DdSettings Bricscad displays Settings dialog box

AutoCAD Command Bricscad Command Notes
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... DdSTrack Bricscad displays Settings dialog box
DdVPoint DdVPoint
DdUcs DdUcs Bricscad displays Explorer for named UCSs
Delay Delay
2010 DelConstraint ...
... DelEData Bricscad erases xdata from entities
DetachURL ...
DgnAdjust ...
DgnAttach ...
DgnClip ...
DgnImport ...
DgnExport ...
DgnLayers ...
DgnMapping ...
Dim Dim
Dim1 Dim1
DimAligned DimAligned
DimAngular DimAngular
DimArc V10 DimArc
DimBreak ...
DimBaseline DimBaseline
DimCenter DimCenter
2010 DimConstraint ...
DimContinue DimContinue
DimDiameter DimDiameter
DimDisassociate V10 DimDisassociate
DimEdit DimEdit
DimHorizontal ...
DimInspect ...
DimJogged ...
DimJogLine ...
... DimLeader Same as Bricscad’s Leader command
DimLinear DimLinear
DimOrdinate DimOrdinate
DimOverride DimOverride
DimRadius DimRadius
DimReassociate ...
DimRegen DimRegen
DimRotated ...
DimSpace ...
DimStyle DimStyle
DimTEdit DimTEdit
DimVertical ...
... Dish Bricscad draws 3D solid model dishes

AutoCAD Command Bricscad Command Notes
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Dist Dist
Divide Divide
... Dome Bricscad draws 3D solid model domes
Donut Donut
Dragmode Dragmode
DrawingRecovery ... Bricscad equivalent: Recover
DrawingRecoveryHide ...
DrawOrder DrawOrder
... DrawOrderByLayer Bricscad controls draworder through layer names
DSettings DSettings
DsViewer ...
DView DView
DwfAdjust ...
DwfAttach ...
DwfClip ...
DwfFormat ...
DwfLayers ...
... DwgCodePage System variable in AutoCAD
DwgProps DwgProps
DxbIn ... Required only for CAD\camera support
DxfIn DxfIn
DxfOut DxfOut

EEEEE

EAttEdit EAttEdit
Edge ...
EdgeSurf EdgeSurf
... EditEData Edits xdata
Elev Elev
Ellipse Ellipse
... Endpoint AutoCAD equivalent: -Osnap Endpoint
Erase Erase
eTransmit V10 eTransmit
ExAcReload
... ExpBlocks AutoCAD equivalent: AdCenter
Explode Explode
... Explorer AutoCAD equivalent: AdCenter
Export Export
2010 ExportDWF ...
2010 ExportDWFx ...
ExportLayout ...
2010 ExportPDF ....
2010 ExportSettings
-ExportToAutocad

AutoCAD Command Bricscad Command Notes
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... ExpUcs Bricscad displays Explorer
Extend Extend
... Extension AutoCAD equivalent: -Osnap Extension
ExternalReferences ... Equivalent Bricscad command: Xref
ExternalReferencesClose ...
Extrude Extrude

FFFFF

... Files Bricscad displays Windows File Explorer
Field V10 Field
Fill Fill
Fillet Fillet
Filter ...
Find Find
FlatShot ... Bricscad equivalent: Flatten
... Flatten Bricscad flattens 3D objects with thickness
Freespot ... Variation on the Light command
Freeweb ... Variation on the Light command

GGGGG

GeographicLocation ...
2010 GeomConstraint ...
GotoUrl ... Bricscad equivalent: OnWeb
Gradient V10 Gradient
GraphScr GraphScr
Grid Grid
Group Group

HHHHH

Handles Handles Inoperative in AutoCAD
Hatch Hatch
HatchEdit ... Bricscad equivalent: Properties
Helix ...
Help Help
Hide Hide Wireframe mode only in AutoCAD
HidePalettes ...
Hyperlink Hyperlink
HyperlinkOptions HyperlinkOptions

IIIII

Id Id
-Image Image Opens Explorer in Bricscad
ImageAdjust ImageAdjust Opens Properties in Bricscad

AutoCAD Command Bricscad Command Notes



9292929292 Bricscad for AutoCAD Users

ImageAttach ImageAttach
ImageClip ImageClip
... ImageFrame System variable in AutoCAD
ImageQuality ImageQuality
Import Import
Imprint ...
Insert Insert
InsertObj InsertObj
Interfere Interfere
Intersect Intersect
... Intersection AutoCAD equivalent: -Osnap Intersection
Isoplane Isoplane

JJJJJ

Join Join
JpgOut ...
JustifyText ...

LLLLL

LayCur ...
LayDel ...
Layer Layer Bricscad displays Explorer for layers.
LayerClose ...
LayerP ...
LayerPalette ... Bircscad equivalent: Layer
LayerPMode ...
LayerState LayerState Bricscad displays Explorer for layer states.
LayFrz LayFrz
LayIso LayIso
LayLck LayLck
LayMch ...
LayMCur LayMCur
LayMrg ...
LayOff LayOff
LayOn LayOn
-Layout Layout
LayoutWizard
LayThw LayThw
LayTrans
LayULk LayULk
LayUnIso ...
LayVpi ...
LayWalk ...
Leader Leader

AutoCAD Command Bricscad Command Notes
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Lengthen Lengthen
... LicEnterKey Enters Bricscad license Key
... LicProperties Bricscad displays license information
Light ...
LightList ...
LightListClose ...
Limits Limits
Line Line
Linetype Linetype Bricscad displays Explorer for linetypes.
List List
LiveSection ...
Load Load
Loft ...
LogFileOn LogFileOn
LogFileOff LogFileOff
LtScale LtScale
LWeight LWeight Bricscad displays Settings

MMMMM

Markup ...
MarkupClose ...
MassProp MassProp
MatchCell ...
MatchProp MatchProp
MaterialAttach ...
MaterialMap ...
Materials ...
MaterialsClose ...
Measure Measure
2010 MeasureGeom ... Bricscad equivalent: Area, Dist, MassProp
Menu Menu
... MenuLoad AutoCAD equivalent: CuiLoad
... MenuUnload AutoCAD equivalent: CuiUnload
2010 Mesh ...
2010 MeshCrease ...
2010 MeshUncrease ...
2010 MeshOptions ...
2010 MeshPrimitiveOptions ...
2010 MeshRefine ...
2010 MeshSmooth ...
2010 MeshSmoothLess ...
2010 MeshSmoothMore ...
2010 MeshSplit ...
... Midpoint AutoCAD equivalent: -OSnap Midpoint

AutoCAD Command Bricscad Command Notes
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MInsert MInsert
Mirror Mirror
Mirror3d Mirror3d
MLeader ...
MLeaderAlign ...
MLeaderCollect ...
MLeaderEdit ...
MLeaderStyle ...
MlEdit ...
MLine ...
MlStyle ...
Model ... Bricscad equivalent: click Model tab
Move Move
... MoveEData Bricscad moves xdata between entities
MRedo
MSlide MSlide
MSpace MSpace
MtEdit ... Bricscad equivalent: Properties
MText MText
MtProp ... Bricscad equivalent: Properties
Multiple Multiple
MView MView
MvSetup ...

NNNNN

NavSMotion ...
NavSMotionClose ...
NavSWheel ...
NavVCube ...
... Nearest AutoCAD equivalent: -Osnap Nearest
NetLoad ...
New New
NewSheetset ...
NewShot ...
NewView ...
... NewWiz Bricscad begins new drawings with wizard
... Node AutoCAD equivalent: -Osnap Node
... None AutoCAD equivalent: -Osnap None

OOOOO

ObjectScale ...
Offset Offset
OleConvert ...
OleLinks OleLinks

AutoCAD Command Bricscad Command Notes
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OleOpen OleOpen
OleReset ...
OleScale ...
... OnWeb Opens Bricsys.com home page
Oops Oops
Open Open
OpenDwfMarkup ...
OpenSheetset ...
Options Options
Ortho Orthogonal
-OSnap OSnap

PPPPP

PageSetup PageSetup
Pan Pan
2010 Parameters ...
2010 ParametersClose ...
PartiaLoad ...
-PartialOpen ...
PasteAsHyperlink ...
PasteBlock PasteBlock
PasteClip PasteClip
PasteOrig V10 PasteOrig
PasteSpec PasteSpec
PcInWizard ...
2010 PdfAdjust ...
2010 PdfAttach ...
2010 PdfClip ...
2010 PdfLayers ...
... PdfOptions Bricscad displays Settings dialog box
PEdit PEdit
... Perpendicular Bricscad object snap
PFace PFace
Plan Plan
PlaneSurf ...
PLine PLine
Plot Plot Operates like AutoCAD’s -Plot command
PlotStamp ... Bricscad equivalent: Print command’s Plot Stamp
PlotStyle PlotStyle
PlotterManager PlotterManager
PngOut ...
Point Point
PointLight ... Variation on the Light command
Polygon Polygon

AutoCAD Command Bricscad Command Notes
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PolySolid ...
PressPull ...
Preview Preview
... Print Operates like AutoCAD’s Plot command
Properties Properties
PropertiesClose PropertiesClose
PSetupIn ...
PSpace PSpace
Publish ...
PublishToWeb ...
Purge Purge
Pyramid Pyramid

QQQQQ

QcClose ...
QDim ...
QLeader ... Bricscad equivalent: Leader
QNew QNew
... QPrint Bricscad plots directly
QSave QSave
QSelect ...
QText QText
QuickCalc ... Bricscad equivalent: Calc
... Quadrant AutoCAD equivalent: -Osnap Quadrant
.... Quick AutoCAD equivalent: -Osnap Quick
QuickCui ...
QuickProperties ...
Quit Quit
QvDrawing ...
QvDrawingClose ...
QvLayout ...
QvLayoutClose ...

RRRRR

Ray Ray
Recover Recover
... ReassocApp Bricscad reassociates apps with xdata
RecoverAll ... Bricscad equivalent: Recover
... RecScript Bricscad begins recording for script file
Rectang Rectang
Redefine Redefine
Redo Redo
Redraw Redraw
RedrawAll RedrawAll

AutoCAD Command Bricscad Command Notes
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RefClose RefClose
RefEdit RefEdit
RefSet RefSet
Regen Regen
RegenAll RegenAll
RegenAuto RegenAuto
Region Region
Reinit Reinit
Rename Rename Bricscad displays Explorer
Render ...
RenderCrop ...
RenderEnvironment ...
RenderExposure ...
-RenderOutputSize
RenderPresets ...
RenderWin ...
ResetBlock ...
Resume Resume
RevCloud RevCloud
2010 Reverse ...
Revolve Revolve
RevSurf RevSurf
Ribbon ...
RibbonClose ...
Rotate Rotate
Rotate3D Rotate3D
RPref ...
RPrefClose ...
RScript RScript
... RtPan AutoCAD equivalent: 3dPan
... RtRot AutoCAD equivalent: 3dOrbit
... RtRotX AutoCAD equivalent: 3dOrbit
... RtRotY AutoCAD equivalent: 3dOrbit
... RtRotZ AutoCAD equivalent: 3dOrbit
... RtZoom AutoCAD equivalent: 3dZoom
RuleSurf RuleSurf

SSSSS

Save Save
... SaveAll Bricscad saves all open drawings
SaveAs SaveAs
... SaveAsR12 Bricscad saves drawings in R12 DWG format
SaveImg ... Bricscad equivalents: Export, MSlide
Scale Scale

AutoCAD Command Bricscad Command Notes
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ScaleListEdit ...
ScaleText ...
Script Script
Section Section
SectionPlane ...
2010 SectionPlaneJog ...
2010 SectionPlaneSettings ...
2010 SectionPlaneToBlock ...
SecurityOptions V10 SecurityOptions
2010 Seek ...
Select Select
SelectURL ... Bricscad equivalent: Hyperlink
... SelGrips AutoCAD equivalent: Ai_SelAll
SequencePlay ...
SetByLayer ...
SetIDropHandler ...
SetVar SetVar
... Shade AutoCAD equivalent: VsCurrent
-ShadeMode ShadeMode
Shape Shape
2010 ShareWithSeek ...
Sheetset ...
SheetsetHide ...
Shell Shell
ShowPalettes ...
SigValidate ...
... Singleton AutoCAD equivalent: SDI system variable
Sketch Sketch
Slice Slice
Snap Snap
SolDraw ...
Solid Solid
SolidEdit SolidEdit
SolProf ...
SolView ...
SpaceTrans ...
Spell Spell
Sphere Sphere
Spline Spline
SplinEdit ... Bricscad equivalent: Properties
Standards ...
... Start Bricscad starts application
... StatBar AutoCAD equivalent: Statbar system variable
Status Status

AutoCAD Command Bricscad Command Notes
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StlOut ...
... StopScript Bricscad stops recording to script file
Stretch Stretch
Style Style Bricscad displays Explorer for styles
StylesManager StylesManager
Subtract Subtract
SunProperties ...
SunPropertiesClose ...
Sweep ...
SysWindows SysWindows

TTTTT

Table ...
TablEdit ...
TableExport ...
TableStyle ...
Tablet Tablet
TabSurf TabSurf
... Tangent AutoCAD equivalent: -Osnap Tangent
Text Text
2010 TextEdit .... Bricscad equivalent: DdEdit
TextScr TextScr
TextToFront ... Bricscad equivalent: DrawOrderByLayer
Thicken ...
TifOut ...
Time Time
TInsert ...

TipOfDay Displays tip for using Bricscad
Tolerance Tolerance
-Toolbar Toolbar
ToolPalettes ...
ToolPalettesClose ...
Torus Torus
TpNavigate ...
Trace ...
Transparency Transparency
TraySettings ...
TreeStat ...
Trim Trim

TxtExp Bricscad explodes text\

UUUUU

U U
Ucs Ucs

AutoCAD Command Bricscad Command Notes
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UcsIcon UcsIcon
UcsMan UcsMan
2010 ULayers ... Bricscad equivalent: Layer
Undefine Undefine
Undo Undo
Union Union
Units Units
UpdateField V10 UpdateField
UpdateThumbsNow ...

Url AutoCAD equivalent: Browser

VVVVV

VbaIde VbaIde
VbaLoad VbaLoad
VbaUnload VbaUnload
VbaMan VbaMan
VbaRun VbaRun
VbaStmt ...
View View Bricscad displays Explorer
ViewPlay ...
ViewPlotDetails ...
ViewRes ViewRes
VisualStyles ... Bricscad equivalent: Shade
VisualStylesClose ...
VLisp ...
... VmlOut Bricscad exports drawings in VML format
VpClip VpClip
VpLayer VpLayer
VpMax ...
VpMin ...
VPoint VPoint
VPorts VPorts
VsCurrent ... Bricscad equivalent: ShadeMode
VSlide VSlide
VsSave ...
VTOptions ...

WWWWW

WalkFlySettings ...
WBlock WBlock
Wedge Wedge
WhoHas ...
WipeOut WipeOut
WmfIn ...

AutoCAD Command Bricscad Command Notes
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WmfOpts ...
WmfOut WmfOut
WorkSpace ...
WsSave ...
WsSettings ...

XXXXX

XAttach XAttach
XBind ...
XClip XClip
XEdges ...
XLine XLine
XOpen ...
Xplode Xplode
-XRef XRef Bricscad displays Explorer

ZZZZZ

Zoom Zoom

22222

... 2dIntersection AutoCAD equivalent: -Osnap Intersection

33333

3D 3D
3dAlign ...
3dArray 3dArray
3dClip ...
3dCOrbit ... Bricscad equivalent: RtRot
3dConfig ...
... 3dConvert Bricscad converts ACIS to polyface meshes
3dDistance
3dDwf ...
3dFace ...
3dFly ...
3dFOrbit ... Bricscad equivalent: RtRot
... 3dIntersection AutoCAD equivalent: -Osnap Intersection
3dMesh 3dMesh
3dMove ...
3dOrbit ... Bricscad equivalent: RtRot
3dOrbitCtr ...
3dPan ... Bricscad equivalent: RtPan
3dPoly 3dPoly

AutoCAD Command Bricscad Command Notes
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AutoCAD Command Bricscad Command Notes

2010 3dPrint ...
3dRotate ...
2010 3dScale ...
3dsIn ...
3dSwivel ...
3dWalk ...
3dZoom ... Bricscad equivalent: RtZoom
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APPENDIXAPPENDIXAPPENDIXAPPENDIXAPPENDIX     BBBBB:::::

AutoCAD-Bricscad
System Variable
Cross-reference

THIS APPENDIX COMPARES the names and values of documented system vari-
ables found in AutoCAD 2010 and Bricscad V10. The variables are sorted alpha-
betically.

Both CAD programs can change the values of system variables through the SetVar command at the
command line and through dialog boxes accessed by these commands:

• AutoCAD — enter the SysVDlg command.

• Bricscad — enter the Settings command.

Bricscad also supports preference variables, additional settings that are controlled by the Settings dialog
box only.

2010 indicates system variables new in AutoCAD 2010.

V10 indicates system variables new in Bricscad V10.

PV indicates preference variables in Bricscad; changed through Settings dialog box only.
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AAAAA

3dConversionMode 1 ...
3dDdwfPrec 2 ...

3dSelectionMode 1 ...
AcadLspAsDoc 0 0 AcadLspAsDoc on_start.lsp for each doc

AcadPrefix c:\users\... C:\Users\... AcadPrefix Program folder path
AcadVer 18.0s (lms tech) 17.0 Bricscad AcadVer AutoCAD version

AcisOutVer 70 70 AcisOutVer Acisout version
ActPath ...

ActRecorderState 0 ...
ActRecPath c:\users\... ...

ActUi 6 ...
AeceipInProgress off ...

AFlags 16 0 AFlags Attribute options
AngBase 0 0 AngBase Angle base

AngDir 0 0 AngDir Angle direction
AnnoAllVisible 1 ...

AnnoAutoScale -4 ...
AnnotativeDwg 0 ...

ApBox 0 0 ApBox Autosnap aperture box
Aperture 2010 2010 Aperture Entity snap aperture

 2010 AppFrameResources pack://application... ...
Area 0 0 Area Area

AttDia 0 0 AttDia Attribute dialog
AttIpe 0 ...

AttMode 1 1 AttMode Attribute display mode
AttMulti 1 ...
AttReq 1 1 AttReq Insertion default settings

AuditCtl 0 0 AuditCtl Audit control
AUnits 0 0 AUnits Angular unit type
AuPrec 0 0 AuPrec Angular unit precision

AutoDwfPublish 0 ...
2010 AutomaticPub 0 ...

... 1 AutoMenuLoad Auto menu load
AutoSnap 63 63 AutoSnap AutoSnap

... 3 AttractionDistance PV Grips attraction distance

... 252 AutoTrackingVecColor PV Color of tracking vector

... 1 V10 AutosaveChecksOnlyFirstBitDBMOS PV

BBBBB

BackgroundPlot 2 ...
BackZ 0 0 BackZ Back clipping plane offset

AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

2010 BActionBarMode 1 ...
BActionColor 7 ...

... "" BaseFile Template
2010 BConStatusMode 0 ...

BDependencyHighlight 1 ...
BGripObjColor 141 ...

BGripObjSize 8 ...
BindType 0 0 BindType Xref bind type

... 256 BkgColor Background color

... 256 BkgColorPs Paper space background color
BlipMode 0 0 Blipmode Blip mode

BlockEditLock 0 ...
BlockEditor 0 ...

... C:\Users\... BlocksPath PV Blocks path
2010 BlockTestWindow 0 ...

BParameterColor 170 ...
BParameterFont simplex.shx ...
BParameterSize 12 ...

2010 BpTextHorizontal 1 ...
BtMarkDisplay 1 ...

BvMode 0 ...

CCCCC

CalcInput 1 ...
CameraDisplay 0 ...
CameraHeight 0 ...

CAnnoScale 01:01:00 AM ...
CAnnoScaleValue 1 ...

CaptureThumbnails 1 ...
2010 CBarTransparency 50 ...

2010 CConstraintForm 0 ...
CDate 20090722.2 20090722.15 CDate Calendar date

CDynDisplayMode 0 ...
CeColor bylayer BYLAYER CeColor Entity color

CeLtscale 1 1 CeLtScale Entity linetype scale
CeLtype bylayer BYLAYER CeLtype Entity linetype

CeLweight -1 -1 CeLweight Entity lineweight
CenterMt 0 ...

ChamferA 0 0.5 ChamferA Chamfer first distance
ChamferB 0 0.5 ChamferB Chamfer second distance
ChamferC 0 1 ChamferC Chamfer length
ChamferD 0 0 ChamferD Chamfer angle

ChamMode 0 0 ChamMode Chamfer mode
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

CipMode 0 ...
CircleRad 0 0 CircleRad Circle radius

CLayer 0 0 CLayer Current layer
CleanScreenState 0 ...

... 1 CliState Command line state

... 1 V10 CloseChecksOnlyFirstBitDBMOD PV

CMaterial bylayer ...
CmdActive 1 1 CmdActive Active command

CmdDia 1 1 CmddDa Command dialogs
CmdEcho 1 1 CmdEcho Command echo

... : CmdLnText Prompt prefix
CmdInputHistoryMax 20 ...

CmdNames setvar Options CmdNames Active Command Name
CMleaderStyle standard ...

CMlJust 0 0 CmlJust Multiline justification
CMlScale 1 1 CmlScale Multiline scale
CMlStyle standard STANDARD CmlStyle Multiline style

... 1 ColorX X axis color

... 3 ColorY Y axis color

... 5 ColorZ Z axis color

... 0 ComAcadCompatibility PV COM Acad compatibility
Compass 0 0 Compass Compass

2010 ConstraintBarDisplay 1 ...
2010 ConstraintBarMode 4095 ...

2010 ConstraintNameFormat 2 ...
2010 ConstraintRelax 0 ...

2010 ConstraintSolveMode 1 ...
Coords 1 1 Coords Coordinates

CopyMode 0 0 CopyMode Copy mode
CPlotStyle bycolor ByColor CPlotStyle Current plot style

CProfile <<unnamed profile>> DEFAULT CProfile Current profile
CrossingAreaColor 20100 ...

CShadow casts and receives shadows ...
CTab model Model CTab Current tab

CTableStyle standard STANDARD CTableStyle Current table style
... 1 CtrlMouse Mouse shortcuts

CursorSize 5 5 CursorSize Crosshairs size
CVPort 2 2 CvPort Current viewport

... #f8f8f8 CmdLineEditBgColor PV Command line edit background color

... #000000 CmdLineEditBgColor PV Command line edit foreground color

... Courier New CmdLineFontName PV Command line font name

... 2010 CmdLineFontSize PV Command line font size

... #ffffdd CmdLineListBgColor PV Command line list background color
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

... #000000 CmdLineListFgColor PV Command line list foreground color

... 0 ContinuousMotion PV Continuous motion

DDDDD

DataLinkNotify 2 ...
Date 2455035.85 2455035.63 Date Current date

... 0 DbcState DbConnect state
DblClkEdit on 1 V10 DblClkEdit

DbMod 5 0 DbMod Modification status
DctCust c:\users\... "" DctCust Custom spelling dictionary
DctMain enu en_US.dic DctMain Main spelling dictionary

2010 DefaultGizmo 0 ...
2010 DefaultIndex 0 ...
DefaultlLghting 1 ...

DefaultLightingType 1 ...
DeflPlStyle bycolor ByColor Deflplstyle Default layer plot style
DefPlStyle bycolor ByColor DefPstyle Default entity plot style

DelObj 1 1 DelObj Delete entity
DemandLoad 3 3 DemandLoad Demand load

DgnFrame 0 ...
DgnImportMax 2010000000 ...

DgnMappingPath c:\users\... ...
DgnOsnap 1 ...

DiaStat 1 1 DiaStat Dialog state
DimADec 0 0 DimADec Dim angle precision

DimAlt off 0 DimAlt Alt units
DimAltD 2 2 DimAltD Alt precision
DimAltF 25.4 25.4 DimAltF Alt multiplier

DimAltRnd 0 0 DimAltRnd Alt roundoff
DimAltTd 2 2 DimAltTd Alt tolerance precision
DimAltTz 0 0 DimAltTz Alt tolerance suppress zeros
DimAltU 2 2 DimAltU Alt unit type
DimAltZ 0 0 DimAltZ Alt suppress zeros

DimAnno 0 ...
DimAPost "" "" DimAPost Alt units prefix/suffix

DimArcSym 0 0 DimArcSym Arc symbol
DimAssoc 2 2 DimAssoc Associativity

DimASz 0.18 0.18 DimASz Arrow size
DimAtFit 3 3 DimAtFit Arrow and text fit

DimAUnit 0 0 DimAUnit Dim angle units
DimAZin 0 0 DimAZin Suppress angle zeros

DimBlk "" "" DimBlk Arrow
DimBlk1 "" "" DimBlk1 Arrow 1
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

DimBlk2 "" "" DimBlk2 Arrow 2
DimCen 0.09 0.09 DimCen Center mark
DimClrD 0 0 DimClrD Dim line color
DimClrE 0 0 DimClrE Ext line color
DimClrT 0 0 DimClrT Text color

2010 DimConstraintIcon 3 ...
DimDec 4 4 DimDec Dim precision
DimDle 0 0 DimDle Dim line ext
DimDli 0.38 0.38 DimDli Dim baseline spacing

DimDsep . . DimDsep Decimal separator
DimExe 0.18 0.18 DimExe Ext line ext
DimExo 0.06 0.06 DimExo Ext line offset

DimFit 3 3 DimFit Fit text
DimFrac 0 0 DimFrac Fractional type

DimFxl 1 1 DimFxl Ext line fixed length
DimFxLon off 0 DimFxLon Ext line fixed

DimGap 0.09 0.09 DimGap Text offset
DimJogAng 45 45 DimJogAng Jogged angle

DimJust 0 0 DimJust Text pos hor
DimLdrBlk "" "" DimLdrBlk Leader arrow

DimLfac 1 1 DimLfac Dim scale linear
DimLim off 0 DimLim Tolerance method

DimLtEx1 "" "" DimLtEx1 Ext line 1 linetype
DimLtEx2 "" "" DimLtEx2 Ext line 2 linetype
DimLtype "" "" DimLtype Dim line linetype
DimLUnit 2 2 DimLUnit Dim units
DimLwD -2 -1 DimLwD Dim line LW
DimLwE -2 -1 DimLwE Ext line LW
DimPost "" "" DimPost Dim prefix/suffix
DimRnd 0 0 DimRnd Dim round
DimSah off 0 DimSah Arrowheads

DimScale 1 1 DimScale Dim scale overall
DimSd1 off 0 DimSd1 Dim line ext 1
DimSd2 off 0 DimSd2 Dim line 2
DimSe1 off 0 DimSe1 Ext line ext 1
DimSe2 off 0 DimSe2 Ext line ext 2
DimSho on on DimSho

DimSoxd off 0 DimSoxd Dim line inside
DimStyle standard STANDARD DimStyle Dimension style

DimTad 0 0 DimTad Text pos vert
DimTDec 4 4 DimTDec Tolerance precision
DimTFac 1 1 DimTFac Tolerance text height
DimTFill 0 0 DimTFill Text fill
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

DimTFillClr 0 BYBLOCK DimTFillClr Text fill color
DimTih on 1 DimTih Text inside align
DimTix off 0 DimTix Text inside
DimTm 0 0 DimTm Tolerance limit lower

DimTMove 0 0 DimTMove Text movement
DimTofl off 0 DimTofl Dim line forced
DimToh on 1 DimToh Text outside align
DimTol off 0 DimTol Tolerance display

DimTolj 1 1 DimTolj Tolerance pos vert
DimTp 0 0 DimTp Tolerance limit upper

DimTSz 0 0 DimTSz Dim tick size
DimTVp 0 0 DimTVp Text offset vert

DimTxSty standard STANDARD DimTxSty Text style
DimTxt 0.18 0.18 DimTxt Text height

2010 DimTxtDirection off ...
DimTzin 0 0 DimTZin Tolerance suppress zeros
DimUnit 2 2 DimUnit
DimUpt off 0 DimUpt Place text manually
DimZin 0 0 DimZin Suppress dim zeros

... 1 DisplaySnapMarker PV Snap marker

... 0 DisplaySnapMarkerInAllViews PV Snap marker in all views

... 1 DisplayTooltips PV Snap tooltips
DispSilh 0 0 DispSilh Display silhouette curves

... 1 DispPaperBkg Display paper background

... 1 DispPaperMargins Display paper margins
Distance 0 0 Distance Distance

2010 DivMeshBoxHeight 3 ...
2010 DivMeshBoxLength 3 ...

2010 DivMeshBoxWidth 3 ...
2010 DivMeshConeAxis 8 ...

2010 DivMeshConeBase 3 ...
2010 DivMeshConeHeight 3 ...

2010 DivMeshCylAxis 8 ...
2010 DivMeshCylBase 3 ...

2010 DivMeshCylHeight 3 ...
2010 DivMeshPyrBase 3 ...

2010 DivMeshPyrHeight 3 ...
2010 DivMeshPyrLength 3 ...

2010 DivMeshSphereAxis 12 ...
2010 DivMeshSphereHeight 6 ...

2010 DivMeshTorusPath 8 ...
2010 DivMeshTorusSection 8 ...

2010 DivMeshWedgeBase 3 ...
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

2010 DivMeshWedgeHeight 3 ...
2010 DivMeshWedgeLength 4 ...

2010 DivMeshWedgeSlope 3 ...
2010 DivMeshWedgeWidth 3 ...

DonutId 0.5 0.5 DonutId Donut inside diameter
DonutOd 1 1 DonutOd Donut outside diameter

DragMode 2 2 DragMode Entity dragging
... 1 DragOpen Drag open

DragP1 2010 2010 DragP1 Regen-drag rate
DragP2 25 25 DragP2 Fast-drag rate
DragVs "" ...

DrawOrderCtl 3 3 DrawOrderCtl Draworder control
DTextEd 2 ...

DwfFrame 2 ...
DwfOsnap 1 ...
DwgCheck 1 0 DwgCheck Drawing check

DwgCodepage ansi_1252 ANSI_1252 DwgCodepage Drawing codepage
DwgName drawing1.dwg Drawing1.dwg DwgName Drawing name
DwgPrefix c:\users\... C:\Users\... DwgPrefix Drawing prefix
DwgTitled 0 0 DwgTitled Drawing titled

... C:\Users\... DrawingPath PV Drawings path
DxEval 12 ...

2010 DynConstraintDisplay 1 ...
2010 DynConstraintMode 1 ...

DynDiGrip 31 ...
DynDiVis 1 ...
DynMode -3 ...

DynPiCoords 0 ...
DynPiFormat 0 ...

DynPiVis 1 ...
DynPrompt 1 ...

DynTooltips 1 ...

EEEEE

EdgeMode 0 0 EdgeMode Edge mode
Elevation 0 0 Elevation Elevation

... 0 EnableAttraction PV Enable grips attraction

... 1 EnableFlyOver PV Snap flyover

... 1 EnableHyperlinkMenu PV Hyperlink menu

... 0 EnableHyperlinkTooltip PV Hyperlink tooltip
EnterpriseMenu . ...

... 0 ErrNo Error number
Expert 0 0 Expert Expert
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

ExplMode 1 1 ExplMode Explode mode
2010 ExportEplotFormat 2 ...
2010 ExportModelSpace 0 ...

2010 ExportPageSetup 0 ...
2010 ExportPaperSpace 0 ...

ExtMax -1e+20,-1e+20,-1e+20 -1e+20,-1e+20,-1e+20 ExtMax Extents maximum
ExtMin 1e+20,1e+20,1e+20 1e+20,1e+20,1e+20 ExtMin Extents minimum

... 1 ExtNames Extend names
ExtNames 1 ...

FFFFF

2010 FacetErDevNormal 40 ...
2010 FacetErDevSurface 0 ...

2010 FacetErGridRatio 0 ...
2010 FacetErMaxEdgeLength 0 ...

2010 FacetErMaxGrid 4096 ...
2010 FacetErMeshType 0 ...
2010 FacetErMinUGrid 0 ...
2010 FacetErMinVGrid 0 ...

2010 FacetErPrimitiveMode 1 ...
2010 FacetErSmoothlev 1 ...

FacetRatio 0 0 FacetRatio Faceting aspect ratio
FacetRes 0.5 0.5 FacetRes Facet resolution

FieldDisplay 1 ...
FieldEval 31 31 FieldEval Field update mode

FileDia 1 1 FileDia File dialog
FilletRad 0 0 FilletRad Fillet radius
FillMode 1 1 FillMode Fill mode
FontAlt simplex.shx simplex.shx FontAlt Alternate font

FontMap c:\users... default.fmp FontMap Font mapping file
2010 Frame 3 ...

FrontZ 0 0 FrontZ Front clipping plane offset
FullOpen 1 1 FullOpen Full open

FullPlotPath 1 ...

GGGGG

GeoLatLongFormat 0 ...
GeoMarkerVisibility 1 ...

GfAng 0 ...
GfClr1 rgb:000,000,255 ...
GfClr2 rgb:255,255,153 ...

GfClrLum 1 ...
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

GfClrState 1 ...
GfName 1 ...
GfShift 0 ...

GridDisplay 2 ...
GridMajor 5 ...
GridMode 0 0 GridMode Grid mode

GridUnit 0.5000,0.5000 0.5;0.5 GridUnit Grid unit
GripBlock 0 0 GripBlock Grips in blocks
GripColor 150 160 GripColor Grip color

GripDynColor 140 ...
GripHot 12 1 V10 GripHot

GripHover 11 3 V10 GripHover
GripObjLimit 20100 20100 GripObjLimit Grip object limit

Grips 1 1 Grips Grips
GripSize 5 5 GripSize Grip size

2010 GripSubobjMode 1 ...
GripTips 1 ...

... 0 V10 GouraudAsPhong

... 0 GsDeviceType PV Graphic system device
GtAuto 1 ...

GtDefault 0 ...
GtLocation 1 ...

HHHHH

HaloGap 0 0 HaloGap Halo gap
Handles 1 1 Handles Publish Handles

... 25 HandSeed Handle seed
HidePrecision 0 0 HidePrecision Hide and shade precision

HideText on 1 HideText Hide text on HIDE
HideXrefScales 1 ...

Highlight 1 1 Highlight Highlight
HpAng 0 0 HpAng Hatch pattern angle

HpAssoc 1 1 V10 HpAssoc
HpBound 1 1 HpBound Hatch pattern boundary
HpDouble 0 0 HpDouble Hatch pattern doubling

HpDrawOrder 3 3 HpDraworder Hatch pattern draw order
HpGapTol 0 0 HpGapTol Hatch boundary gap size
HpInherit 0 ...

HpMaxLines 201000000 ...
HpName ansi31 ANSI31 HpName Hatch pattern name

HpObjWarning 2010000 10000 V10 HpObjWarning
HpOrigin 0.0000,0.0000 0;0 HpOrigin Hatch pattern origin

HpOriginMode 0 ...
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

HpScale 1 1 HpScale Hatch pattern scale
HpSeparate 0 ...

HpSpace 1 1 HpSpace Hatch pattern spacing
... 0 HpStyle Hatch pattern style

HyperlinkBase . . HyperlinkBase Hyperlink base

IIIII

ImageFrame 1 ...
ImageHlt 0 0 ImageHlt Image highlight

Impliedface 1 ...
IndexCtl 0 0 IndexCtl Index control

InetLocation http://www.autodesk.com http://www.bricsys.com InetLocation Internet location
InputHistoryMode 15 ...

InsBase 0.0,0.0,0.0 0;0;0 InsBase Insertion base point
InsName . . InsName Insertion name
InsUnits 1 1 InsUnits Insertion units

InsUnitsdefSource 1 1 InsUnitsDefSource Insertion units default source
InsUnitsdefTarget 1 1 InsUnitsDefTarget Insertion units default target
IntelligentUpdate 20 ...

InterfereColor 1 ...
InterfereObjVs realistic ...
InterfereVpVs 3d wireframe ...

IntersectionColor 257 257 IntersectionColor Intersection color
IntersectionDisplay off 0 IntersectionDisplay Intersection display

ISaveBak 1 1 ISaveBak Incremental save backup
ISavePercent 50 50 ISavePercent Save percent

Isolines 4 4 Isolines Isolines

LLLLL

2010 LargeObjectSupport 0 ...
LastAngle 0 0 LastAngle Last angle
LastPoint 5.7,13.5,0.0 0;0;0 LastPoint Last point

LastPrompt lastangle : options LastPrompt Last prompt
Latitude 37.8 ...

LayerDlgMode 1 ...
LayerEval 0 ...

LayerEvalCtl 1 ...
LayerFilterAlert 2 ...

LayerNotify 0 ...
LayLockFadeCtl 50 ...
LayoutRegenCtl 2 2 LayoutRegenCtl Layout regeneration control
LegacyCtrlPick 0 ...
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

LensLength 50 50 LensLength Lens length
... 0 LicFlags Licensed components

LightGlyphDisplay 1 ...
LightingUnits 2 ...

LightsInBlocks 1 ...
LimCheck 0 0 LimCheck Limits check

LimMax 12.0000,9.0000 12;9 LimMax Limits maximum
LimMin 0.0000,0.0000 0;0 LimMin Limits minimum

LinearBrightness 0 ...
LinearContrast 0 ...

... 1 LispInit LISP init
Locale enu enu Locale Locale

LocalRootPrefix c:\users\... c:\users\... LocalRootPrefix Local root prefix
LockUi 0 ...

LoftAng1 90 ...
LoftAng2 90 ...
LoftMag1 0 ...
LoftMag2 0 ...

LoftNormals 1 ...
LoftParam 7 ...

LogExpBrightness 65 ...
LogExpContrast 50 ...
LogExpDaylight 2 ...

LogExpMidtones 1 ...
LogExpPhysicalScale 1500

LogFileMode 0 0 LogFileMode Log file mode
LogFileName c:\users\... "" LogFileName Log file name

LogFilePath c:\users\... c:\users\... LogFilePath Log file path
LogInName <login> Bricscad user LogInName Login name

Longitude -122.39 ...
LtScale 1 1 LtScale Linetype scale
LUnits 2 2 LUnits Linear unit type

LuPrec 4 4 LuPrec Linear unit precision
LwDefault 211 25 LwDefault Default lineweight
LwDisplay off 0 LwDisplay Lineweight display

... 0.55 LwDispScale Lineweight display scale
LwUnits 1 1 LwUnits Lineweight units

MMMMM

... 0 MacroRec Macro recording
MaxActVp 64 64 MaxActVp Maximum active viewports

... 20100000 MaxHatch Maximum hatch dashes
MaxSort 201000 201000 MaxSort Maximum sort
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

MButtonPan 1 1 MButtonPan Middle button pan
MeasureInit 0 1 MeasureInit Measurement initial

Measurement 0 1 Measurement Measurement
MenuBar 0 ...
MenuCtl 1 1 MenuCtl Menu control

MenuEcho 0 0 MenuEcho Menu echo
MenuName c:\users\... default MenuName Menu name

2010 MeshType 1 ...
MirrText 0 0 MirrText Mirror text

MLeaderScale 1 ...
ModeMacro "" "" ModeMacro Mode macro
MsOleScale 1 1 MsOleScale Model space OLE scale

MsLtScale 1 ...
MTextColumn 2 ...

MTextEd internal Internal MTextEd Multiline text editor
MTextFixed 2 ...

MTextToolbar 2 ...
MTJigString abc ...

MyDocumentsPrefix c:\users\... ...

NNNNN

NavsWheelMode 2 ...
NavsWheelOpacityBig 50 ...

NavsWheelOpacityMini 50 ...
NavsWheelSizeBig 1 ...

NavsWheelSizeMini 1 ...
NavvCubeDisplay 1 ...

NavvCubeLocation 0 ...
NavvCubeOpacity 50 ...

NavvCubeOrient 1 ...
NavvCubeSize 4 ...

... 4 NFileList Recent file list
NoMutt 0 0 NoMutt No muttering

NorthDirection 0 ...

OOOOO

Obscuredcolor 257 257 ObscuredColor Obscured color
Obscuredltype 0 0 ObscuredLtype Obscured linetype

Offsetdist -1 1 OffsetDist Offset distance
Offsetgaptype 0 0 Offsetgaptype Offset type

Oleframe 2 ...
Olehide 0 0 OleHide OLE hide
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

OleQuality 3 3 OleQuality OLE quality
OleStartup 0 0 OleStartup OLE startup

OpenPartial 1 1 OpmState Properties bar state
OrthoMode 0 0 OrthoMode Orthogonal mode

OsMode 4133 4133 OsMode Entity snap mode
OsnapCoord 2 2 OsnapCoord Entity snap coordinates
OsnapHatch 0 ...

OsnapZ 0 ...
OsOptions 3 ...

PPPPP

PaletteOpaque 2 ...
... 1 V10  PanBuffer

PaperUpdate 0 0 PaperUpdate Paper update
2010 ParameterCopyMode 1 ...

2010 ParameterStatus 0 ...
... 1 PdfEmbeddedTtf PV Pdf embedded fonts

2010 PdfFrame 1 ...
... 1 PdfLayersSetting PV Pdf layer support
... 0 PdfLayoutsToExport PV Pdf layouts to export

2010 PdfOsnap 1 ...
... 297 PdfPaperHeight PV Pdf overridden paper height
... 0 PdfPaperSizeOverride PV Pdf papersize override
... 210 PdfPaperWidth PV Pdf overridden paper width
... 0 PdfShxTextAsGeometry PV Pdf SHX text as geometry
... 1 PdfSimpleGeomOptimization PV Pdf simple geometry optimization
... 0 PdfTtfTextAsGeometry PV Pdf TTF text as geometry
... 1 V10  PdfUsePlotStyles PV

... 1 PdfZoomToExtentsMode PV Pdf zoom to extents mode
PdMode 0 0 PdMode Point display mode

PdSize 0 0 PdSize Point display size
PeditAccept 0 ...

PEllipse 0 0 PEllipse Polyline ellipse
Perimeter 0 0 Perimeter Last perimeter

Perspective 0 ...
PerspectiveClip 5 ...

PfacevMax 4 4 PFaceVMax Polyface mesh maximum vertices
PickAdd 1 1 PickAdd Pick add

PickAuto 1 1 PickAuto Pick automatic
PickBox 3 3 PickBox Pick box

PickDrag 0 0 PickDrag Pick drag
PickFirst 1 1 PickFirst Pick first
PickStyle 0 1 PickStyle Pick style
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

Platform varies varies Platform Platform
2010 PlineConvertMode 0 ...

PlineGen 0 0 PlineGen Polyline generation
PlineType 2 2 PlineType Polyline type
PlineWid 0 0 PlineWid Polyline width

... c:\users\... PlotCfgPath PV Plotter configuration path
PlotOffset 0 ...

... c:\program files... PlotOutputPath PV Plot output path
PlotRotMode 2 ...

... c:\users\... PlotStylePath PV Plot styles path
PlQuiet 0 0 PlQuiet Plot quiet

PolarAddAng . . PolarAddAng Polar add angles
PolarAng 90 90 PolarAng Polar angle
PolarDist 0 0 PolarDist Polar distance

PolarMode 0 0 PolarMode Polar mode
PolySides 4 4 PolySides Polygon sides

Popups 1 1 Popups Popups
PreviewEffect 2 2 PreviewEffect Selection preview effect
PreviewFilter 7 7 PreviewFilter Selection preview filter
PreviewType 0 ...

... 1 PreviewWndInOpenDlg PV Preview window in open dialog

... "" ProjectSearchPaths PV Project search paths

... 3 PromptMenu Prompt menu

... 0 PromptMenuFlags PV Prompt menu flags

... Bricscad Product Product

... 1 ProgBar Progress bar

... Bricscad Program Program
ProjectName . . ProjectName Project name

ProjMode 1 1 ProjMode Projection mode
ProxyGraphics 1 1 ProxyGraphics Proxy graphics

ProxyNotice 1 1 ProxyNotice Proxy notice
ProxyShow 1 1 ProxyShow Proxy show

ProxyWebSearch 0 1 ProxyWebSearch Proxy web search
PsLtScale 1 1 PsLtScale Paper space linetype scale

PsolHeight 4 ...
PsolWidth 0.25 ...
PsProlog . ...
PsQuality 75 ...

PStyleMode 1 1 PStyleMode Plot style mode
PStylePolicy 1 1 PStylePolicy Plot style policy

PsVpScale 0 0 PsVpScale Paper space viewport scale
PublishAllSheets 1 ...

PublishCollate 1 ...
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

PublishHatch 1 ...
PUcsBase . . PUcsBase Paper space UCS base

Q

QpLocation 0 ...
QpMode 1 ...

... 0 QaFlags Quality Assurance flags
QtextMode 0 0 QtextMode Quick text mode

QvDrawingPin 0 ...
QvLayoutPin 0 ...

RRRRR

RasterDpi 300 ...
RasterPercent 20 ...
RasterPreview 1 1 RasterPreview Raster preview

RasterThreshold 20 ...
... 5 RealtimeSpeedup PV Realtime speedup
... C:\Users\... RecentPath PV Recent path

RecoveryMode 2 ...
... 0 RefEditLockNotInWorkset PV Refedit lock

RefEditName "" "" RefEditName Refedit name
RegenMode 1 1 RegenMode Regeneration mode

RememberFolders 1 1 RememberFolders Remember folders
... 0 Re_init Reinitialize Aliases

RenderQuality 1 ...
RenderUserLights 1 ...

ReportError 1 ...
... 0 RevCloudArcStyle PV Revision cloud default arc style
... 0.38 RevCloudMaxArcLength PV Revision cloud default max arc length
... 0.38 RevCloudMinArcLength PV Revision cloud default min arc length

2010 RibbonContextSelect 1 ...
2010 RibbonContextSelLim 2500 ...
2010 RibbonDockedHeight 0 ...

2010 RibbonSelectMode 1 ...
RibbonState 1 ...

Roamablerootprefix c:\users\... c:\users\... RoamableRootPrefix Roamable root prefix
RolloverTips 1 ...

RtDisplay 1 1 RtDisplay Realtime display

SSSSS

... 1 SaveChangeToLayout PV Save changes to layout
SaveFidelity 1 ...
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

SaveFile c:\users\... "" SaveFile Save file name
SaveFilePath c:\users\... C:\Users\... SaveFilePath Save file path

... 1 SaveFormat PV Save format
SaveName Drawing1.dwg Drawing1.dwg SaveName Saved drawing name
SaveTime 2010 2010 SaveTime Save time interval

ScreenBoxes 0 26 ScreenBoxes Screen menu boxes
ScreenMode 3 1 ScreenMode Screen mode

ScreenSize 1366.0,499.0 784.0;506.0 ScreenSize Screen size
... 256 ScrlHist Scroll history
... 0 Sdi Single-document interface

SelectionAnnoDisplay 1 ...
SelectionArea 1 ...

SelectionAreaOpacity 25 ...
SelectionPreview 3 3 SelectionPreview Selection preview display
SetByLayerMode 127 ...

ShadEdge 3 3 ShadEdge Shading edges
ShadeDif 70 70 ShadeDif Shading diffusion

ShadowPlaneLocation 0 ...
ShortcutMenu 11 2 ShortcutMenu Shortcut menus

... 0 ShowFullPathInTitle PV Display full path in title
ShowHist 1 ...

ShowLayerUsage 0 ...
ShowmotionPin 1 ...

ShpName "" "" ShpName Shape name
SigWarn 1 ...

SketchInc 0.1 0.1 SketchInc Sketch increment
SkPoly 0 0 SkPoly Sketch poly

SkyStatus 0 ...
... 0 SingletonMode PV Singleton mode

2010 SmoothMeshConvert 0 ...
2010 SmoothMeshGrid 3 ...

2010 SmoothMeshMaxFace 838300 ...
2010 SmoothMeshMaxLev 4 ...

SnapAng 0 0 SnapAng Snap angle
SnapBase 0.0000,0.0000 0;0 SnapBase Snap base

SnapIsoPair 0 0 SnapIsoPair Snap isometric pair
... 2 SnapMarkerColor PV Snap marker color
... 6 SnapMarkerSize PV Snap marker size
... 2 SnapMarkerThickness PV Snap marker thickness

SnapMode 0 0 SnapMode Snap mode
SnapStyl 0 0 SnapStyl Snap style

SnapType 0 0 SnapType Snap type
SnapUnit 0.5000,0.5000 0.5;0.5 SnapUnit Snap unit
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

SolidCheck 1 1 SolidCheck Solid check
SolidHist 1 ...
SortEnts 127 96 SortEnts Sort entities

SplFrame 0 0 SplFrame Spline frame
SplineSegs 8 8 SplineSegs Spline segments
SplineType 6 6 SplineType Spline type

... c:\users\... SrchPath Support File Search path
SsFound "" ...
SsLocate 1 ...

SsmAutoOpen 1 ...
SsmPollTime 60 ...

SsmSheetStatus 2 ...
StandardsViolation 2 ...

Startup 0 0 Startup Startup
StatusBar 1 ...

StepSize 6 ...
StepsPerSec 2 ...

2010 SubobjSelectionMode 0 ...
SunStatus 0 ...

SurfTab1 6 6 Surftab1 Surface tabulation 1
SurfTab2 6 6 Surftab2 Surface tabulation 2
SurfType 6 6 SurfType Surface-fitting type

SurfU 6 6 SurfU Surface U
SurfV 6 6 SurfV Surface V

SyscodePage ansi_1252 ANSI_1252 SysCodePage System code page

TTTTT

TableIndicator 1 ...
TableToolbar 2 ...

TabMode 0 0 TabMode Tablet mode
Target 0.0,0.0,0.0 0.0;0.0;0.0 Target Target

TdCreate 2455034.61 2455035.58 TdCreate Time/Date create
TdInDwg 1.24 1.16E-008 TdInDwg Time/Date in drawing

TduCreate 2455034.9 2455035.88 TduCreate Time/Date universal create
TdUpdate 2455034.61 2455035.58 TdUpdate Time/Date update

TdUsrTimer 1.24 1.16E-008 TdUsrTimer Time/Date user timer
TduUpdate 2455034.9 2455035.88 TduUpdate Time/Date universal update

... c:\users\... TemplatePath PV Path to templates folder
TempOverrides 1 ...

TempPrefix c:\users\... "" TempPrefix Temporary prefix
... 0 TextAngle Text angle

2010 TextEditor 0 ...
TextEval 0 0 TextEval Text evaluation
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

TextFill 1 1 TextFill Text fill
TextOutputFileFormat 0 ...

TextQlty 50 50 TextQlty Text quality
TextSize 0.2 0.2 TextSize Text size

TextStyle standard STANDARD TextStyle Text style
Thickness 0 0 Thickness Thickness

ThumbSize 1 ...
TileMode 1 1 TileMode Tile mode

TimeZone -8000 ...
ToolTipMerge 0 ...

Tooltips 1 ...
*_ToolPalettePath C:\Users\...

TraceWid 0.05 0.05 TraceWid Trace width
TrackPath 0 0 TrackPath Track path
TrayIcons 1 ...
TrayNotify 1 ...

TrayTimeout 0 ...
TreeDepth 3020 3020 TreeDepth Tree depth

TreeMax 2010000000 2010000000 TreeMax Tree maximum
TrimMode 1 1 TrimMode Trim mode

TSpaceFac 1 1 TSpaceFac Text space factor
TSpaceType 1 1 TSpaceType Text space type
TStackAlign 1 2 TStackAlign Text stack align
TStackSize 70 70 TStackSize Text stack size

... c:\users\... TemplatePath Template path

UUUUU

UcsAxisAng 90 90 UcsAxisAng UCS axis angle
UcsBase WORLD "" UcsBase UCS base

UcsDetect 1 ...
UcsFollow 0 0 UcsFollow UCS follow

UcsIcon 3 3 UcsIcon UCS icon
... 0 UcsIconPos UCS icon position

UcsName "" "" UcsName UCS name
UcsOrg 0.0,0.0,0.0 0;0;0 UcsOrg UCS origin

UcsOrtho 1 ...
UcsView 1 ...

UcsVp 1 1 UcsVp UCS viewports
UcsXDir 1.0,0.0,0.0 1;0;0 UcsXDir UCS X direction
UcsYDir 0.0,1.0,0.0 0;1;0 UcsYDir UCS Y direction
UndoCtl 53 1 UndoCtl Undo control

UndoMarks 0 5 UndoMarks Undo marks
UnitMode 0 0 UnitMode Unit mode
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

2010 UOsnap 1 ...
UpdateThumbnail 15 ...

... 1 UseOutputFolder PV Use output folder

... 0 UseRegistryValues PV Reuse previous print settings
UserI1 0 0 UserI1 User integer 1
UserI2 0 0 UserI2 User integer 2
UserI3 0 0 UserI3 User integer 3
UserI4 0 0 UserI4 User integer 4
UserI5 0 0 UserI5 User integer 5

UserR1 0 0 UserR1 User real 1
UserR2 0 0 UserR2 User real 2
UserR3 0 0 UserR3 User real 3
UserR4 0 0 UserR4 User real 4
UserR5 0 0 UserR5 User real 5
UserS1 "" "" UserS1 User string 1
UserS2 "" "" UserS2 User string 2
UserS3 "" "" UserS3 User string 3
UserS4 "" "" UserS4 User string 4
UserS5 "" "" UserS5 User string 5

... 0 UseStandardOpenFileDialog PV Use standard open file dialog

VVVVV

... Bricsys _VendorName Vendor name

... 9.2.16 (UNICODE) _VerNum Version number

... 20100.0.38 VersionCustomizableFiles PV Version customizable files
ViewCtr 18.9,8.7,0.0 18.9,8.7,0.0 ViewCtr View center
ViewDir 0.0,0.0,1.0 2010.4;4.5;0.0 ViewDir View direction

ViewMode 0 0.0;0.0;1.0 ViewMode View mode
ViewSize 14.65 16 ViewSize View size

ViewTwist 0 0 ViewTwist View twist
VisRetain 1 1 VisRetain Visibility retain

VpLayerOverrides 0 ...
VpLayerOverridesMode 1 ...

VpMaximizedState 0 ...
2010 VpRotateAssoc 1 ...

VsBackgrounds 1 ...
VsEdgecolor byentity ...
VsEdgejitter -2 ...

VsEdgeoverhang -6 ...
VsEdges 1 ...

VsEdgesmooth 1 ...
VsFacecolormode 0 ...
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AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable

VsFacehighlight -30 ...
VsFaceopacity -60 ...

VsFacestyle 0 ...
VsHalogap 0 ...

VsHideprecision 0 ...
VsIntersectionColor white ...

VsIntersectionEdges 0 ...
VsIntersectionLtype 1 ...

VsIsoOnTop 0 ...
VsLightingQuality 1 ...

VsMaterialMode 0 ...
VsMax 119.3,59.5,0.0 ... VsMax Virtual screen maximum
VsMin -81.3,-42.1,0.0 ... VsMin Virtual screen minimum

VsMonoColor rgb:255,255,255 ...
VsObscuredColor byentity ...

VsObscuredEdges 1 ...
VsObscuredlLype 1 ...

VsShadows 0 ...
VsSilhEdges 0 ...
VsSilhWidth 5 ...

VtDuration 750 ...
VtEnable 3 ...

VtFps 7 ...

WWWWW

WhipArc 0 0 WhipArc Whip arcs
WhipThread 1 3 WhipThread Whip threads

WindowAreaColor 150 ...
WmfBkgnd off 0 WmfBkGnd Windows Meta File background

WmfForegnd off 0 WmfForeGnd Windows Meta File foreground
... 2 WndlMain Main window state
... 2 WndlMdi MDI windows state
... 0 WndlScrl Window scrollbars
... 1 WndlStat Window status bar
... 1 WndlTabs Layout and model tabs
... 0 WndlText Text window state
... 2162.0;202.0 WndpMain Main window top left
... 40.0;40.0 WndpText Text window top left
... 1160.0;760.0 WndsMain Main window size
... 1120.0;720.0 WndsText Text window size

WorldUcs 1 1 WorldUcs World UCS
WorldView 1 1 Worldview World view

... 1 WorkSpaceSecurity PV Enable macros
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WriteStat 1 ..
WsCurrent 2D drafting & annotation ...

XXXXX

XClipFrame 2 0 XClipFrame Xref clipping frame
2010 XDwgFadeCtl 70 ...

XEdit 1 1 XEdit Xref editable
XFadeCtl 50 50 XFadeCtl Xref fade control
XLoadCtl 2 2 XLoadCtl Xref load control

XLoadPath c:\users\... C:\Users\... XLoadPath Xref load path
XRefCtl 0 0 XRefCtl Xref control

XRefNotify 2 ...
XRefType 0 ...

ZZZZZ

ZoomFactor 60 60 ZoomFactor Zoom factor
ZoomWheel 0 ...

AutoCAD AutoCAD Bricscad Bricscad Notes
System Variable Default Value Default Value System Variable
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     APPENDIXAPPENDIXAPPENDIXAPPENDIXAPPENDIX     CCCCC:::::

AutoCAD-Bricscad
Alias Cross-reference

THIS APPENDIX COMPARES the default command aliases defined by AutoCAD
and Bricscad. The list is sorted alphabetically by command name.

Both CAD programs can define new aliases and modify existing ones. To customize
aliases in

• AutoCAD — use the Command Aliases button on the ribbon’s Express Tool tab’s Tools panel.

• Bricscad — use the Customize command’s Keyboard Shortcuts node.

*) Aliases marked with an asterisk are included by Bricscad for compatibility with IntelliCAD.
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AutoCAD Command AutoCAD Alias BricsCAD Alias BricsCAD Command

AAAAA

ActRecord arr ...
-ActStop -ars ...
ActStop ars ...
ActUserInput aru ...
-ActUserMessage -arm ...
Actusermessage arm ...
Adcenter adc,content,dc,dcenter
Align al al Align
AllPlay aplay ...
... ap Aperture
... planviewint* Apparent
AppLoad ap ...
Arc a a Arc
Area aa aa Area
-Array -ar ...
Array ar ar Array
-AttDef -att -at -AttDef
AttDef att,ddattdef at,ddattdef AttDef
... ad AttDisp
-AttEdit -ate,atte -ax,ax,ddattext -AttExt
AttEdit ate,ddatte,ddattext -ate AttEdit
AttIpEdit ati ...

BBBBB

... backgrounds* Background
BAction ac ...
... ba Base
BClose bc
BcParameter cparam
BEdit be
... bm Blipmode
-Block -b -b -Block
Block b,acadblockdialog, ...

bmake,bmod
-Boundary -bo -bo -Boundary
Boundary bo,bpoly bo,bpoly Boundary
BParameter param ...
Break br br Break
BSave bs ...
BvState bvs ...
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CCCCC

Camera cam ...
Chamfer cha cha Chamfer
Change -ch -ch Change
CheckStandards chk ...
Circle c,col,colour,ddcolor c Circle
CommandLine cli ...
ConstraintBar cbar ...
ConstraintSettings csettings ...
-Color -col,-colour -col,-colour -Color
Color col,colour,ddcolor, col,colour,ddcolor, Color

ddcolour ddcolour,setcolor*
Copy co,cp co,cp Copy
... cl CopyLink
... cui Customize
CTableStyle ct ...
Cylinder cyl cyl Cylinder

DDDDD

DataExtraction dx ...
DataLink dl ...
DataLinkUpdate dlu ...
DbConnect dbc ...
DdEdit ed ed DdEdit
DdGrips gr gr DdGrips
... se DdSelect
DdVpoint vp vp,setvpoint*,viewctl DdVpoint
DelConstraint delcon ...
... dimension Dim
DimAligned dal,dimali dal,dimali DimAligned
DimAngular dan,dimang dan,dimang DimAngular
Dimarc dar ...
DimBaseline dba,dimbase dba,dimbase DimBaseline
DimCenter dce dce Dimcenter
DimConstraint dcon ...
Dimcontinue dco,dimcont dco,dimcont DimContinue
DimDiameter ddi,dimdia ddi,dimdia DimDiameter
DimDisassociate dda ...
DimEdit ded,dimed ded,dimed DimEdit
DimJogged jog,djo ...
DimJogline djl ...
DimLinear dli,dimlin,dimhorizontal, dli,dimlin,dimvertical, DimLinear

dimrotated,dimvertical dimhorizontal,
dimrotated

AutoCAD Command AutoCAD Alias BricsCAD Alias BricsCAD Command
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DimOrdinate dor,dimord dor,dimord DimOrdinate
DimOverride dov,dimover dov,dimover DimOverride
DimRadius dra,dimrad dra,dimrad DimRadius
DimReassociate dre ...
... -dst -Dimstyle
DimStyle d,dst,dimsty,ddim d,ddim,dimsty,ds, dst DimStyle

expdimstyles,setdim*
DimTedit dimted dimted DimTedit
Dist di di Dist
Divide div div Divide
Donut do,doughnut do,doughnut Donut
DrawingRecovery drm ...
DrawOrder dr dr DrawOrder
DSettings ds,ddrmodes,se ddrmodes,rm DSettings
DsViewer av ...
DView dv dv DView

EEEEE

EditShot eshot ...
... ate EAttEdit
Ellipse el el Ellipse
Erase e e,delete Erase
... b,xb ExpBlocks
Explode x x Explode
-Export -qpub ...
Export exp exp,dwfout Export
ExportDwf edwf ...
ExportDwfx edwfx ...
ExportPdf epdf ...
-ExportToAutocad aectoacad ...
... uc,dducs ExpUcs
Extend ex ex Extend
ExternalReferences er ...
Extrude ext ext Extrude

FFFFF

Fillet f f Fillet
Filter fi fi Filter
FlatShot fshot

GGGGG

GeographicLocation geo,north,northdir
GeomConstraint gcon

AutoCAD Command AutoCAD Alias BricsCAD Alias BricsCAD Command



appendix C • AutoCAD-Bricscad Alias Cross-reference 129129129129129

Gradient gd ...
... g Grid
-Group -g ...
Group g ...

HHHHH

-Hatch -h -h,-bh -Hatch
Hatch h,bh h,bh Hatch
HatchEdit he he HatchEdit
Hide hi hi Hide
HidePalettes poff ...

IIIII

... idpoint* Id
-Image -im ...
Image im im,expimages* Image
ImageAdjust iad iad ImageAdjust
ImageAttach iat iat ImageAttach
ImageClip icl icl ImageClip
Import imp imp Import
-Insert -i -i -Insert
Insert i,ddinsert,inserturl i,ddinsert Insert
... insal InsertAligned
InsertObj io io InsertObj
Interfere inf inf Interfere
Intersect in in Intersect
... is Isoplane

JJJJJ

Join j ...

LLLLL

-Layer -la -la -Layer
Layer la,ddlmodes la,ddlmodes Layer

,explayers*
LayerState las,lman las LayerState
... setlayer* LayMcur
-Layout lo ...
Leader lead le,lead Leader
Lengthen len len,editlen* Lengthen
... lighting Light
Line l l,3dline Line

AutoCAD Command AutoCAD Alias BricsCAD Alias BricsCAD Command
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-Linetype -lt,-ltype -lt -Linetype
Linetype lt,ltype,ddltype lt,ddltype,expltypes* Linetype
List li,ls,showmat li,ls List
Ltscale lts lts LtScale
Lweight lw,lineweight ...

MMMMM

Markup msm ...
MatchProp ma,painter ma MatchProp
MaterialMap setuv setuv MaterialMap
Materials mat,rmat,finish mat,finish,rmat Materials
Measure me ...
MeasureGeom mea ...
MeshCrease crease ...
MeshRefine refine ...
MeshSmooth smooth ...
MeshSmoothLess less ...
MeshSmoothMore more ...
MeshSplit split ...
MeshUncrease uncrease ...
Mirror mi mi Mirror
Mirror3d 3dmirror 3m,3dmirror Mirror3d
MLeader mld ...
MLeaderAlign mla ...
MLeaderCollect mlc ...
MLeaderEdit mle ...
MLeaderStyle mls ...
MLine ml ...
Move m m Move
... msnapshot* MSlide
MSpace ms ms MSpace
-MText -t ...
MText mt,t mt,t MText
MView mv mv MView

NNNNN

NavSMotion motion ...
NavSMotionClose motioncls ...
NavSWheel wheel ...
NavVCube cube ...
NewShot nshot ...
NewView nview ...
... ddnew NewWiz

AutoCAD Command AutoCAD Alias BricsCAD Alias BricsCAD Command
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OOOOO

Offset o o Offset
... undelete,unerase Oops
Open openurl,dxfin op Open
Options op,preferences cfg,config,prefs, Options

preferences
... ortho,or Orthogonal
-Osnap -os -os,esnap -OSnap
Osnap os,ddosnap os,ddosnap, Osnap

ddesnap,setesnap*

PPPPP

-Pan -p ...
Pan p p, -p Pan
-Parameters -par ...
Parameters par ...
-PartialOpen partialopen
PasteSpec pa pa PasteSpec
PEdit pe pe,editpline* PEdit
PLine pl pl,polyline* Pline
Plot print,dwfout ...
PlotStamp ddplotstamp ...
Point po po Point
PointLight freepoint ...
Polygon pol pol Polygon
PolySolid psolid ...
Preview pr,pre pre,ppreview* Preview
Properties props,ch,mo,ddchprop, pr,props,ch,mo, Properties

ddmodify ddchprop,ddmodify
PropertiesClose prclose prc PropertiesClose
PSpace ps ps PSpace
PublishToWeb ptw ...
-Purge -pu -pu -Purge
Purge pu pu Purge
Pyramid pyr pyr Pyramid

QQQQQ

QLeader le ...
... n QNew
... qt QText
QuickCalc qc ...
QuickCui qcui ...
Quit exit exit Quit

AutoCAD Command AutoCAD Alias BricsCAD Alias BricsCAD Command
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QvDrawing qvd ...
QvDrawingClose qvdc ...
QvLayout qvl ...
QvLayoutClose qvlc

RRRRR

Rectang rec,rectangle rec,rect,rectangle Rectang
Redraw r r Redraw
RedrawAll ra ra RedrawAll
Regen re re Regen
RegenAll rea rea RegenAll
Region reg reg Region
... ri Reinit
-Rename -ren -ren -Rename
Rename ren ren,ddrename Rename
Render rr rr Render
RenderCrop rc ...
RenderEnvironment fog fog RenderEnvironment
RenderPresets rp,rfileopt roptions RenderPresets
RenderWin rw,rendscr rendscr RenderWin
Revolve rev rev Revolve
Ribbon dashboard ...
RibbonClose dashboardclose ...
Rotate ro ro Rotate
... 3r,3drotate Rotate3d
RPref rpr setrender RPref

SSSSS

Save saveurl sa Save
SaveAs dxfout ...
Scale sc sc Scale
Script scr scr Script
Section sec sec Section
... selgrip SelGrips
SectionPlane splane ...
SectionPlaneJog jogsection ...
SectionPlaneToBlock generatesection ...
SequencePlay splay ...
... ucp,dducsp SetUcs
SetVar set set SetVar
... sha Shade
ShadeMode sha,shade vscurrent ShadeMode
SheetSet ssm ...

AutoCAD Command AutoCAD Alias BricsCAD Alias BricsCAD Command
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ShowPalettes pon ...
... freehand* Sketch
Slice sl sl Slice
Snap sn sn Snap
Solid so so,plane* Solid
Spell sp sp Spell
Spline spl spl Spline
SplinEdit spe spe SplinEdit
Standards sta ...
Stretch s s Stretch
... font* -Style
Style st,ddstyle st,ddstyle,expfonts*, Style

expstyle,expstyles
Subtract su su Subtract

TTTTT

Table tb ...
TableStyle ts ...
Tablet ta ta Tablet
... -t -Text
Text dt,dtext tx Text
TextEdit tedit ...
Thickness th th Thickness
TileMode ti,tm ...
... ti Time
Tolerance tol tol Tolerance
Toolbar to ...
ToolPalettes tp ...
Torus tor tor Torus
Trim tr tr Trim

UUUUU

Ucs dducs ...
UcsMan uc,dducs,dducsp ...
Union uni uni Union
-Units -un -un -Units
Units un,ddunits un, ddunits Units

VVVVV

... vba VbaIde
-View -v -v -View
View v,ddview v,ddview,expviews* View
ViewGo vgo ...

AutoCAD Command AutoCAD Alias BricsCAD Alias BricsCAD Command
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ViewPlay vplay ...
-VisualStyles -vsm ...
VisualStyles vs,vsm ...
... vl VpLayer
VPoint -vp viewpoint*,-vpoint, VPoint

-viewpoint,vscurrent
VPorts viewports vw,vport,viewports VPorts
... vs,vsnapshot* VSlide

WWWWW

-WBlock -w ...
WBlock w,acadwblockdialog w WBlock
... closeall WClosAall
Wedge we we Wedge
... wi WmfIn
... wo WmfOut

XXXXX

XAttach xa xa XAttach
-XBind -xb ...
XBind xb -xb XBind
XClip xc clip XClip
XLine xl xl, infline* XLine
-XRef -xr -xr -Xref
XRef xr xr,expxrefs* Xref

ZZZZZ

Zoom z z Zoom

33333

3dAlign 3al ...
3dArray 3a 3a,array3d 3dArray
3dFace 3f face,3dprint 3dFace
... mesh 3dMesh
3dMove 3m ...
3dOrbit 3do,orbit ...
3dPoly 3p 3p 3dPoly
3dPrint 3dp,3dplot, ...

rapidprototype
3dRotate 3r ...
3dSale 3s ...
3dWalk 3dnavigate,3dw ...

AutoCAD Command AutoCAD Alias BricsCAD Alias BricsCAD Command
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APPENDIXAPPENDIXAPPENDIXAPPENDIXAPPENDIX     DDDDD:::::

AutoCAD-Bricscad
Keystroke and Button

Cross-reference

THIS APPENDIX COMPARES the default shortcut keystrokes and buttons defined
by AutoCAD and Bricscad. The comparison lists are sorted into these groups:

Drawing Area

Function keys

Ctrl keys

Shift keys

Other keys

Text Window and Command Bar

Ctrl and other keys

Shortcuts Sorted by AutoCAD Commands

Mouse and Tablet Buttons

Mouse buttons

Tablet buttons

Both CAD programs can define new shortcuts and buttons, and modify existing ones. Keystroke shortcuts
are customized in the following ways:

• AutoCAD — use the Cui command’s Keyboard Shortcuts node.

• Bricscad — use the Customize command’s Keyboard tab.

To learn how to customize Bricscad, see the Customizing Bricscad ebook available for purchase from the
www.Bricsys.com Web site.
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Shortcuts by AutoCAD CommandsShortcuts by AutoCAD CommandsShortcuts by AutoCAD CommandsShortcuts by AutoCAD CommandsShortcuts by AutoCAD Commands

AutoCAD Command Keystroke Equivalent Bricscad Bricscad
Command Action

AAAAA

AdCenter Ctrl+2 ...
AdcClose
AutoSnap Shift+X ...
AutoSnap Shift+. ...

CCCCC

CleanScreenOn Ctrl+0 ...
CleanScreenOff
Close Ctrl+F4 WClose Closes the current drawing
CommandLine Ctrl+9 ...
CommandLineHide
Coords Ctrl+I ...
CopyBase Ctrl+Shift+C CopyBase Copies selected objects with basepoint
CopyClip Ctrl+C CopyClip Copies selected objects to Clipboard
CutCut Ctrl+X CutClip Cuts selected entities to Clipboard

DDDDD

dbConnect Ctrl+6 ...
dbClose
DynMode F12 ...

EEEEE

Erase Del Erase Erases selected objects
Esc Ctrl+[ ...

Ctrl+\

GGGGG

GridMode F7 Grid T Toggles the display of the grid
Ctrl+G

HHHHH

Help F1 Help Displays the Help dialog box
HidePalettes Ctrl+Shift+H ...
Hyperlink Ctrl+K ...
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IIIII

Isoplane F5 Isoplane Cycles through isoplanes
Ctrl+E

LLLLL

Layout Set Ctrl+PageUp ...
Ctrl+PageDown

MMMMM

Markup Ctrl+7 ...
MarkupClose Ctrl+7 ...

NNNNN

NavSWheel Shift+W ...
New Ctrl+N New Opens the New Drawing dialog box

OOOOO

Open Ctrl+O Open Opens the Open Drawing dialog box
Ortho Shift ...
OrthoMode F8 Orthogonal T Toggles orthogonal mode

Ctrl+L
Shift+L

OsMode Ctrl+F ...
Shift+A

-Osnap F3 Osnap T Toggles object snap mode
-OSnap Cen Shift+C ...

Shift+,
-Osnap End Shift+E ...

Shift+P
-OSnap Mid Shift+M ...

Shift+V
-OSnap Non Shift+D ...
-OSnap Off Shift+' ...
OsnapOverride Shift+S ...

Shift+;

AutoCAD Command Keystroke Equivalent Bricscad Bricscad
Command Action
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PPPPP

PasteBlock Ctrl+Shift+V PasteBlock Pastes entities from Clipboard as a block
PasteClip Ctrl+V PasteClip Paste entities from Clipboard
PickStyle Ctrl+H ...
Plot Ctrl+P Print Displays the Print dialog box
PolarMode F11 AddInMan Displays the VBA Add-In Manager dialog box

Shift+Q
Shift+]

Properties Ctrl+1 ...
PropertiesOff

QQQQQ

Qsave Ctrl+S QSave Saves the current drawing
QuickCalc Ctrl+8 ...
QcClose
QuickProperties Ctrl+Shift+P ...
Quit Ctrl+Q ...

RRRRR

Redo Ctrl+Y Redo Redoes the last undo

SSSSS

SaveAs Ctrl+Shift+S ...
SheetSet Ctrl+4 ...
SheetSetHide
SnapMode F9 Snap T Toggles snap mode

Ctrl+B
SnapType F10 StatBar Toggles the display of the status bar

Ctrl+U

TTTTT

Tablet F4 Tablet T Toggles tablet mode
Ctrl+T

TextScr F2 PmtHist Toggles between Text and Graphics windows
ToolPalettes Ctrl+3 ...
ToolPalettesOff Ctrl+3 ...

AutoCAD Command Keystroke Equivalent Bricscad Bricscad
Command Action
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UUUUU

U Ctrl+Z U Undoes the last command
UcsDetect F6 Coordinate T Cycles through coordinate display modes

Ctrl+D
Shift+Z
Shift+/

VVVVV

VbaIde Alt+F11 VBA Opens the Visual Basic Editor
VbaRun Alt+F8 ...
^V (*) Ctrl+R ... (*) AutoCAD uses an undocumented command

OtherOtherOtherOtherOther

(*) Ctrl+Shift+A ... (*) AutoCAD uses an undocumented command
(ai_SelAll) (*) Ctrl+A SelGrips All Select all non-frozen objects
(Windows) Ctrl+F6 (Windows) Switches to the next drawing

AutoCAD Command Keystroke Equivalent Bricscad Bricscad
Command Action
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Mouse and Tablet ButtonsMouse and Tablet ButtonsMouse and Tablet ButtonsMouse and Tablet ButtonsMouse and Tablet Buttons

The following tables compare the actions of mouse and tablet buttons in AutoCAD and Bricscad.

Mouse ButtonsMouse ButtonsMouse ButtonsMouse ButtonsMouse Buttons

AutoCAD customizes the definitions of mouse buttons in the Mouse Buttons and Double-click Actions nodes
of its Customize User Interface dialog box. Bricscad does not customize its mouse buttons.

Mouse Button AutoCAD Action Bricscad Action

1 (left) Picks objects* Picks objects
2 (right) Displays grips shortcut menu Displays context-sensitive shortcut menu
3 (center) Displays object snap shortcut menu Pans in real time
4 Cancels the current command ...
5 Toggles snap mode ...
6 Toggles ortho mode ...
7 Toggles grid display ...
8 Changes the coordinate display ...
9 Switches to the next isoplane ...
10 Toggles tablet mode ...

Wheel Zooms in real time * Zooms in real time
Double-click 1 (left) Edits selected object(s) Edits selected object(s)

Shift+2 (right) Displays object snap shortcut menu ...
Shift+3 (center) Rotates viewpoint in 3D ...

Ctrl+1 (left) ... Rotates viewpoint in 2D
Ctrl+2 (right) Displays object snap shortcut menu Rotates viewpoint in 3D
Ctrl+3 (middle) Swivels viewpoint in 3D ...
Ctrl+4 Zooms viewpoint in 3D ...

Note:
*) The actions of the pick button (#1) and wheel cannot be customized by AutoCAD.
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Tablet ButtonsTablet ButtonsTablet ButtonsTablet ButtonsTablet Buttons

AutoCAD customizes the definitions of stylus and puck buttons in the Tablet Buttons node of its Customize
User Interface dialog box’s Legacy section. Bricscad customize buttons in the Digitizer Buttons node of the
Customize dialog box’s Tablet tab. The action of Button 1 cannot be changed.

Left: Tablet button definitions in AutoCAD’s CUI dialog box.
Right: Tablet button definitions in Bricscad’s Customize dialog box.

Tablet Button AutoCAD Action Bricscad Action

1 Picks objects Picks objects
2 Displays grips shortcut menu Redraws the drawing
3 Displays object snap shortcut menu Regenerates the drawing
4 Cancels the current command Cancels the current command
5 Toggles snap mode Toggles snap mode
6 Toggles ortho mode Toggles ortho mode
7 Toggles grid display Toggles grid display
8 Changes the coordinate display Changes the coordinate display
9 Switches to the next isoplane Copies selected objects to the Clipboard
10 Toggles tablet mode Pastes objects from the Pasteboard
11 ... Opens the Properties Bar
12 ... Opens the Drawing Explorer
13 ... Zooms into the drawing
14 ... Pans the drawing
15 ... Zooms out of the drawing
16 ... ...

Shift+2 Displays object snap shortcut menu ...


